Pro8432WT

-1-

●●
About the Product Warranty
Every effort has been made to ensure that the information in this document is complete, accurate,
and up-to-date. The manufacturer assumes no responsibility for the results of errors beyond its
control. The manufacturer also cannot guarantee that changes in software and equipment made by
other manufacturers and referred to in this guide will not affect the applicability of the information
in it. Mention of software products manufactured by other companies does not necessarily constitute
endorsement by the manufacturer.
While all reasonable efforts have been made to make this document as accurate and helpful as
possible, we make no warranty of any kind, expressed or implied, as to the accuracy or completeness
of the information contained herein.

All rights are reserved by Oki Electric Industry Co., Ltd. You must not copy, transfer, translate, etc. the
content herein without authorization. You must obtain written permission from Oki Electric Industry
Co., Ltd. before doing any of the above.
© 2017 Oki Electric Industry Co., Ltd.
OKI is a registered trademark of Oki Electric Industry Co., Ltd.
Energy Star is a trademark of the United States Environmental Protection Agency.
Microsoft, Windows, Windows Server and Windows Vista are registered trademarks of Microsoft
Corporation.
Apple, Mac, OS X and macOS are registered trademarks of Apple Inc.
Other product names and brand names are registered trademarks or trademarks of their proprietors.
This product complies with the requirements of the Council Directives 2014/30/EU (EMC), 2014/35/
EU (LVD), 2014/53/EU (RED), 2009/125/EC (ErP) and 2011/65/EU(RoHS), as amended where
applicable, on the approximation of the laws of the member states relating to Electromagnetic
Compatibility, Low Voltage, Radio & Telecommunications Terminal Equipment, Energy related
Products and Restriction on the use of certain Hazardous Substances in electrical and electronic
equipment.

The following cables were used to evaluate this product for EMC directive 2014/30/EU compliance, and
configurations other than this may affect that compliance.
cable type

length
(meters)

Power

1.8

USB

5.0

LAN

15.0
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core

shield

●●
Emergency first aid
Take care with toner powder:
If swallowed, give small amounts of cold water and seek medical attention. DO
NOT attempt to induce vomiting.
If inhaled, move the person to an open area for fresh air. Seek medical attention.
If it gets into the eyes, flush with large amounts of water for at least 15 minutes
keeping eyelids open. Seek medical attention.
Spillages should be treated with cold water and soap to help reduce risk of
staining skin or clothing.
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●●
Environmental information
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●●
For Your Safety
Read the User’s Manual for your safety before using the product.

Cautions related to safety
WARNING
CAUTION

A warning provides additional information which, if ignored, may result in a risk of personal
injury.
A caution provides additional information which, if ignored, may result in equipment
malfunction or damage.

General cautions
WARNING
Do not touch the safety
switch inside the printer.
Doing so may cause electric
shock when high voltage
occurs. In addition, the
rotating gears may result in
injury.

Do not use highly flammable
sprays near the printer. Doing
so may cause fire as parts of
the printer are hot.

Unplug the power cord and
contact a customer service
center if a liquid such as
water enters in the internal
parts of the printer.
Failure to do so may lead to
a fire.
Unplug the power cord
and contact a customer
service center if the printer
is dropped or the cover is
damaged.
Failure to do so may cause
electric shock and/or fire,
leading to injuries.

Unplug the power cord and
remove foreign materials
such as paper clips if they
fall inside the printer. Failure
to do so may cause electric
shock and/or fire, leading to
injuries.
Unplug the power cord
periodically to clean plug
blades and base section
between the blades.
If the power plug remains
inserted for a long time, the
base section will get dusty,
and the plug may short
circuit, which may cause fire.
Do not put a cup with liquids
such as water on the printer.
Doing so may cause electric
shock and/or fire leading to
personal injuries.
Do not use a power cord, a
cable, or a ground wire other
than those that are indicated
in User's Manual.
Doing so may cause fire.

Do not insert materials in a
vent hole.
Doing so may cause electric
shock and/or fire leading to
personal injuries.
Do not throw toner cartridges
and image drum cartridges
into fire. Doing so may cause
dust explosion leading to
burns.

Unplug the power cord
and contact a customer
service center if the cover
is unusually hot, smoking,
giving off an unusual odor,
or making strange noises.
Failure to do so may lead to
a fire.
Do not operate and/or
disassemble the printer other
than as directed in User’s
Manual. Doing so may cause
electric shock and/or fire,
leading to injuries.
Do not clean spilled toner
with a vacuum cleaner.
If cleaning spilled toner with
a vacuum cleaner, it may
catch fire due to the sparks
from electric contact.
Toner spilled on the floor
should be wiped off with wet
cloth.
Do not touch the fuser and
other parts when opening the
cover of the printer.
Doing so may cause burns.
The operation of using UPS
(uninterruptible power
source) or inverters is not
guaranteed. Do not use
uninterruptible power source
or inverters.
Doing so may cause fire.

CAUTION
Do not come closer to the paper’s exit area
when the power is turned on, while printing.
Doing so may result in personal injury.

Do not touch a damaged liquid-crystal display.
If liquid (liquid crystal) leaked from the liquidcrystal display gets into the eyes or mouth, flush
with large amount of water. Follow the direction
from a doctor if necessary.
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●●
Manual Composition
The following manuals are included with this product.
●● Quick Guide
This notes brief descriptions of how to install this printer.
●● User’s Manual (Setup) ---- This document
Basic operations are described to aid understanding of this printer. The initial setup descriptions
including printer placement and the network initial setting are noted along with troubleshooting and
maintenance procedures.

●●
About This Manual
Terms in this document
The following terms are used in this manual.
Note

●● Indicates important information on operations. Make sure to read sections with this mark.
Memo

●● Indicates additional information on operations. You should read sections with this mark.
Reference

●● Indicates where to look when you want to know more detailed or related information.

WARNING
●● A warning provides additional information which, if ignored, may result in a risk of personal injury.

CAUTION
●● A caution provides additional information which, if ignored, may result in equipment malfunction or
damage.

Symbols in this document
The following symbols are used in this manual.
Symbols
[ ]
" "

< > button/key
>
Your Printer

Description
●● Indicates menu names on the display screen.
●● Indicates menu, window, and dialog names on the computer.
●● Indicates messages and input text on the display screen.
●● Indicates file names on the computer.
●● Indicates reference titles.
Indicates a hardware button on the operator panel or a key on the keyboard of the
computer.
Indicates how to get to the item you want in the menu of this printer or the computer.
Indicates a printer you want to use or select.
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Notation used in this manual
The following notations may be used in this manual.
●● PostScript3 Emulation→ PSE, POSTSCRIPT3 Emulation, POSTSCRIPT3 EMULATION
●● Microsoft® Windows® 10 64-bit Edition operating system→ Windows 10 (64bit version) *
●● Microsoft® Windows® 8.1 64-bit Edition operating system→ Windows 8.1 (64bit version) *
●● Microsoft® Windows® 8 64-bit Edition operating system→ Windows 8 (64bit version) *
●● Microsoft® Windows® 7 64-bit Edition operating system→ Windows 7 (64bit version) *
●● Microsoft® Windows Vista® 64-bit Edition operating system→ Windows Vista (64bit version) *
●● Microsoft® Windows Server® 2016 64-bit Edition operating system→ Windows Server 2016 *
●● Microsoft® Windows Server® 2012 R2 64-bit Edition operating system→ Windows Server 2012 *
●● Microsoft® Windows Server® 2012 64-bit Edition operating system→ Windows Server 2012 *
●● Microsoft® Windows Server® 2008 R2 64-bit Edition operating system→ Windows Server 2008 *
●● Microsoft® Windows Server® 2008 64-bit Edition operating system→ Windows Server 2008 (64bit version) *
●● Microsoft® Windows® 10 operating system→ Windows 10 *
●● Microsoft® Windows® 8.1 operating system→ Windows 8.1 *
●● Microsoft® Windows® 8 operating system→ Windows 8 *
●● Microsoft® Windows® 7 operating system→ Windows 7 *
●● Microsoft® Windows Vista® operating system→ Windows Vista *
●● Microsoft® Windows Server® 2008 operating system→ Windows Server 2008 *
●● Generic name for Windows 10, Windows 8.1, Windows 8, Windows Server 2016, Windows Server 2012,
Windows 7, Windows Vista, and Windows Server 2008→ Windows
* I f there is no special description, 64bit version is included in Windows 10, Windows 8.1, Windows 8, Windows 7,
Windows Vista, and Windows Server 2008. (64bit version and Windows Server 2008 R2 is included in Windows
Server 2008, Windows Server 2012 R2 is included in Windows Server 2012.)
If there is no special description, Windows 7 is used as Windows, OS X 10.11 is used as OS X, and Pro8432WT is
used as the printer for examples in this document.
Depending on your OS, model or version, the description on this document may be different.

The diffusion of dust, ozone, styrene, benzene, TVOC, and ultrafine particles conforms to the Eco Mark
155, “Printer” substance emission certification criteria. (Toner was tested by performing black and
white and color printing with OKI genuine toner cartridges according to the appendix S-M of the Blue
Angel RAL UZ-171:2012 test method.)
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1. Setup

1. Setup

How to set up is explained in this chapter.

 Setup Flow
1. Checking Products
●● Checking package contents
●● Checking names of the operator panel and how to
operate
●● Checking names of product parts
●● Checking options

2. Checking the Placement Environment
●● Checking the placement environment
●● Checking placement location

3. Preparing a Printer
●● Unpacking
●● Removing cushioning materials
●● Installing consumables
●● Loading paper
●● Turning on/off the power
●● Installing options
●● Test printing from the printer

4. Connecting to a Computer
Connecting through network
For Windows

Connecting through USB

For OS X
Connecting through Bonjour

For Windows

For OS X

Specifying an IP address
on the operator panel

Connecting a cable

Installing a printer driver on a computer

Adding printers on a computer

Test printing from a computer
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Adding printers on a
computer

Checking Products

●●
Checking Products

1

This section gives an overview of the printer.
●● Software DVD-ROM

Check that you have everything shown below.

CAUTION

It may cause injury!

●● At least two people are needed to lift the printer
safely because it weighs about 37 Kg.

●● AC cord

Reference

●● For details on how to open the package, refer to
“Unpacking” P.17.

●● Printer

Note

●● An Ethernet cable and USB cable are not supplied with
your printer. Procure them separately.
●● Packaging and cushioning material are needed if
transporting the printer. Do not throw them away.

●● Four image drums (cyan, yellow, magenta,
white)
Note

●● The image drums are installed in the machine before
shipment.

●● Four starter toner cartridges (cyan, yellow,
magenta, white)

●● Quick Guide
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1. Setup

Checking Package Contents

Operator Panel

Operator Panel
1 ●●
1. Setup

This section explains the names and functions of components on the operator panel and how to enter
text.
1

2

5

12

9

8
11

13

No.

7

6

Name

1
2
3
4

Display screen
<ON LINE> button
<CANCEL> button
<ENTER> button

5
6
7

<SCROLL> button
<BACK> button
<HELP> button

8

<POWER SAVE> button

9

Numeric Keypad

10
11

<Fn> key
<CLEAR> key

12
13

<READY> indicator
<ATTENTION> indicator

Each time a numeric key is pressed, entered
numbers or characters are changed cyclically in
the following order:
→
→
→
→
→
→

3 10

Function

Use to enter numbers and characters.

1
2
3
4
5
6
7

4

Displays operating instructions and the status of the printer.
Switches between on line and off line modes.
Cancels the current print immediately.
●● Displays the menu screen.
●● Confirms the highlighted item.
Selects the menu or scrolls the screen.
Returns to the previous screen.
Displays the help screen. To close, press the <HELP> button, <BACK>
button, or <CANCEL> button.
●● Enters or exits the power saving mode.
●● Exits the deep sleep mode.
Lights up green in the power save mode and blinks green in the deep sleep mode.
●● Enters numbers.
●● Enters alphabetical characters and symbols.
A password can be entered only with numeric keypad.
Displays the equipment setting menu screen with a shortcut function.
Executes the following actions according to the entered items when pressed
or held down.
●● Minimizes a setting value.
●● Enters zero for a setting value.
●● Deletes a character.
●● Cancels a selected item.
Returns to the previous settings. Not available when entering an IP address.
Lights up green in on line mode and turns off in off line mode.
Lights up or blinks orange when an error occurs in the device.

How to Use the Numeric
Keypad

<1>:
<2>:
<3>:
<4>:
<5>:
<6>:
<7>:

5

a→b→c→A→B→C→2
d→e→f→D→E→F→3
g→h→i→G→H→I→4
j→k→l→J→K→L→5
m→n→o→M→N→O→6
p→q→r→s→P→Q→R→S→7

<8>: 8 → t → u → v → T → U → V → 8
<9>: 9 → w → x → y → z → W → X → Y → Z → 9
<0>: 0
The functions of < > and <C> keys are the
followings:
< >: Function key (Available only when the
standby screen is displayed.)
<C>: Deletes a character when entering a
password.
To enter “abc” for example,
press <2> → <2> → <ENTER> button → <2>
→ <2> → <2> → <ENTER> button → <2> →
<2> → <2> → <2> → <ENTER> button.
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Operator Panel

Function No.

How to Use the Function Key
Press numeric keys after pressing the <Fn>
key when the message “Ready To Print”
appears on the display screen. The function
menu corresponding to the number entered is
displayed.

1

Press the <Fn> key.

2

Press the numeric keys (0-9) to display
the desired function item and press the
<ENTER> button.

Network
Error Log
Power Save Time
Sleep Time
Auto Power Off Time
Error Report
Print Position Adjust (MPTray)
Print Position Adjust (Tray 1)
Paper Color Setting
Trans. Color Setting
SMR Setting
BG Setting
Drum Cleaning
Hex Dump
Adjust Density
Adjust Registration
Print Color Tuning Pattern
Cyan Density
Magenta Density
Yellow Density
White Density

Names of Components
3

The setting screen of the selected
function is displayed. Check or change
the settings.

2

5
3

8
4

6
8

Function Menu List
Function No.
1
2
10
11
12
13
14
80
90
91
92
93
94
95
100

1

7

No.

Function menu

1
2
3
4
5
6
7
8

Shared Print
Private Print
Paper Size (Tray 1)
X Dimension (Tray 1)
Y Dimension (Tray 1)
Media Type (Tray 1)
Media Weight (Tray 1)
Paper Feed
Paper Size (MP Tray)
X Dimension (MP Tray)
Y Dimension (MP Tray)
Media Type (MP Tray)
Media Weight (MP Tray)
Tray Usage (MP Tray)
Configuration
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Name
Front cover
Front cover open lever
Operator panel
Power switch
Output tray
Multipurpose tray
Tray 1
Air vents

1
1. Setup

101
103
200
201
202
210
220
221
231
233
234
235
236
237
300
301
302
310
311
312
313

Function menu

Operator Panel

9

1

18
13

1. Setup

12

15

11
10

19
21

14

20

No.
No.
9
10
11
12
13
14
15

18
19
20
21

Name
Output tray open button
Toner cartridge
Image drum (C: cyan)
Toner cartridge
Image drum (Y: yellow)
Toner cartridge
Image drum (M: magenta)
Toner cartridge
Image drum (W: white)
Fuser unit
LED head (four heads)

23
24
25

No.
23
24
25

26
17

No.

Rear output tray
AC power socket
Interface part
Access cover

●● Interface part

16

16
17
26

Name

Name
Multipurpose tray
Paper set cover
Wireless LAN module cover
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Name
Accessory connector
USB interface connection
Network interface connection

Operator Panel

Available Options

1
1. Setup

The following options are available for your
printer:
●● Additional RAM (256 MB or 512 MB)
●● 16 GB SD memory card kit
●● Wireless LAN module
Reference

●● For details on how to install the options, refer to
“Installing Options” P.23.
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Checking the Placement Environment

Checking the Placement Environment
1 ●●
1. Setup

Placement Environment
Your printer must be placed in the following
environment:
Temperature:
Humidity:
Maximum
wet bulb
temperature:
Recommended
environment:

10 - 32°C
20% - 80% RH
(relative humidity)
25°C

Placement Space
Place your printer on a flat surface that is wide
enough that the printer’s feet securely on the
surface.
Allow for enough room around your printer as
shown in the images below.
●● Top view
20 cm

17 - 27°C, 50 - 70 % RH

Note

●● Be careful of condensation. It may cause a malfunction.
●● If placing your printer in a location where the humidity of
the surrounding air is less than 30% RH, use a humidifier
or antistatic mat.

WARNING
●● Do not install near high temperature or the fire.
●● Please do not install in a place from which a
chemical reaction is started (laboratory etc.).
●● Do not install near the inflammable solution, such
as alcohol and thinner.
●● Do not install in the place which the small child's
hand reaches.
●● Do not install in an unstable place (the shaky
stand, leaning place, etc.).
●● Do not install in a place many humidity, dusty and
the place where direct rays hit.
●● Do not install in the environment of briny air and
corrosive gas.
●● Do not install in a place with much vibration.
●● Do not install in a place where the ventilation hole
of the printer is closed.

60 cm

100 cm
20 cm

●● Side view

70 cm

CAUTION
●● Do not place directly on a rug or carpet with long
strands.
●● Do not install in a closed room with poor
ventilation and circulation.
●● If you use the printer in a small room for a long
time, please make sure that you ventilate the
room.
●● Install away from strong magnetic fields and
sources of noise.
●● Install away from monitors or TVs.
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Preparing Your Printer

●●
Preparing Your Printer

1

This section explains how to unpack your printer and how to turn it on and off.

CAUTION

Installing Consumables
1

It may cause injury!

●● At least two people are needed to lift the printer
safely because it weighs about 37 Kg.

Insert your finger into the recess on
the right side of the printer and pull the
front cover open lever (1) to open the
front cover (2) forward.
Note

Note

●● Open the front cover gently. If opening rapidly, an MP
tray may open.

●● Be sure to use the consumables or maintenance units
provided with this printer at first. Otherwise, the life of the
consumables or maintenance units may not be displayed
correctly, or you may not be able to use them later.
●● The image drum (the green tube) is very delicate. Handle
it carefully.
●● Do not expose the image drum to direct sunlight or very
bright interior light (approximately more than 1500 lux).
Even under the normal interior light, do not leave it for
more than 5 minutes.

1

●● Packaging and cushioning material are needed if
transporting the printer. Do not throw them away.

1

2

2

Remove your printer from the box and
remove all cushioning materials and the
plastic bag from your printer.

2

Remove the two strips of protective tape
(1) at the back of your printer.

Press the output tray open button (3)
and open the output tray (4).
3
4

1

3
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Take out all four image drums from the
printer.

1. Setup

Unpacking

Preparing Your Printer

1

4

Remove the protective sheets and toner
covers from four image drums.

5

x4 (C / Y / M / W)

1. Setup
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Confirm that the image drum and the
toner cartridge are of the same color,
and then attach the toner cartridge to
the image drum.

Preparing Your Printer

6

Put all four image drums back into a
printer.

Loading Paper

1

Reference

1

7

Pull out the paper tray (1).

Close the output tray (4) by pushing the
both sides of the cover firmly.
4

1

2

Set the paper size dial (2) to match the
loading paper size.
Set the dial to [A4
] when loading the A4 size
paper with a landscape orientation.

2

8

Close the front cover (2).
Note

●● The front cover cannot be closed securely if the
output tray is not closed.
●● When the error message that the top or front cover
is open does not disappear from the operator panel’s
display screen, make sure they are closed securely.

2
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1. Setup

●● Please refer to “Supported Paper” P.45 for information
on how to load paper into the printer.

Preparing Your Printer

1

3

Slide the paper guide (3) and paper
stopper (4) to the size of paper to be
loaded.

5

Load paper with the print side face down
and press it from above.
Note

1. Setup

●● Do not load paper exceeding the [ ] mark (5) of the
paper guide.
5

4
3
Note

●● When loading the A6 size paper, move the paper
stopper (4) forward and remove it once, then install
it on the metal part.
4

6

Secure the loaded paper with the paper
guide.

7

Check if a size of loaded paper matches
the setting of paper size dial.

8

Return the paper tray to the printer.
Memo

4

●● If loading a paper that you cannot select the
size with a paper size dial options, set the dial to
[Other], and then set a paper size on the operator
panel.

Flex paper back and forth, and then fan
it. Straighten the edges of the paper
stack on a level surface.
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Preparing Your Printer

Turning On/Off the Power

1

Plug the AC cord (1) into the AC power
socket of your printer.

The power supply must meet the following
conditions:
Voltage:
Frequency:

110 - 127 VAC (Range 99 - 140 VAC)
220 - 240 VAC (Range 198 - 264 VAC)
50/60 Hz ± 2%

1

Note

●● If the power supply is unstable, use a voltage regulator.
●● The maximum power consumption of this printer is
1400 W. Ensure that the power supply is sufficient to
operate this printer.
●● We do not guarantee operation where an uninterruptible
power system (UPS) or inverter is used. Do not use an
uninterruptible power system (UPS) or inverter.

WARNING

2

Plug the AC cord into the electric socket.

3

Hold down the power switch (2) for
about 1 second to turn on the power.

There is a risk of getting
an electric shock and/or
causing fire.

●● Be sure to turn off the power supply switch when
attaching or removing the AC cable and earth wire.
●● Be sure to connect an earth wire to the grounding
terminal of exclusive use.
●● Please do not connect with the ground of a water pipe,
a gas pipe, and a telephone wire, and a lightning rod by
any means.
●● Make sure to connect with the ground terminal before
connecting the power cord to the power supply plug.
●● Be sure to plug in and unplug the AC cable while holding
on to the power supply plug.
●● Insert the AC cable plug completely into the wall socket
securely.
●● Do not touch the power cord, or printer, if your hands
are wet.
●● Install a power cord in the place which is not stepped
on, and do not place a thing on a power cord.
●● Do not use the cord tied in a bundle.
●● Please do not use the damaged power cord.
●● Do not use multi-outlet adapters.
●● Do not connect this printer and other electric products
to the same wall socket. If it connects simultaneously
with an air conditioner, copier, shredder, etc. Especially,
a printer may incorrect-operate by the electric
noise. When you connect with the same wall socket
unavoidably, please use a commercial noise filter or a
commercial noise cut transformer.
●● Use the attached power cord and insert it directory with
the ground terminal. Do not use the power cord for
other product for the printer.
●● Do not use an extension cord. When you use it
unavoidably, use the thing more than rated 15 A.
●● Use of an extended code may not operate a printer
normally by AC voltage descent.
●● During printing, do not shut off a power supply or do not
pull out a power supply plug.
●● When you use it neither for consecutive holidays nor a
travel for a long time, pull out a power cord.
●● Do not use attached power cord to the other products.

2

The Power switch LED indicator lights up when
the printer turns on.
The message “Ready To Print” is displayed in
the operator panel once printer is ready.
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1
1. Setup

Power Supply Conditions

Turning On the Power

Preparing Your Printer

1

Turning Off the Power

Power Save Mode and Deep Sleep Mode

1

Two-phase power conservation enables you to
save on power consumed by the printer.

1. Setup

Hold down the power switch (1) for
about a second.
The message “Shutting down Please wait.
Printer will turn off automatically” appears
in the operator panel, and the power switch
indicator blinks every 1 second. Then the printer
turns off automatically and the power switch
indicator goes out.

 Power Save Mode

When your printer is not used for a certain
period of time, it automatically enters the power
save mode to reduce the power consumption.
You can enter the power save mode manually
by pressing the <POWER SAVE> button on the
operator panel.

Note

●● It may take about 5 minutes to turn off the power.
Wait until it turns off.

The <POWER SAVE> button lights up green
while in this mode.

●● Holding down the power switch for more than 5
seconds turns off printer forcibly. Only perform
this procedure when a problem occurs. For printer
problems, refer to “Other Issues” P.83.

Memo

●● By factory default, the time interval before entering the
power save mode is set to 1 minute. For how to change
the time that elapses before the printer enters the power
save mode, refer to “Setting the Time that Elapses Before
Entering the Power Save Mode” P.58.

1

 Deep Sleep Mode
 When the Printer is Not Used for a
Long Time
When the printer is not used for a long time due
to consecutive holidays or when on vacation, or
when changing or attaching parts in repair or
maintenance, unplug the AC cord.
Memo

●● The printer will not be functionally impaired even if left
unplugged for a long time (more than 4 weeks).

Your printer goes from the power save mode to
the deep sleep mode after a set period of time.
The <POWER SAVE> button blinks while in the
deep sleep mode.
Note

●● The printer does not enter the deep sleep mode if an error
occurs.
Memo

●● By factory default, the time interval before entering the
deep sleep mode is set to 15 minutes. For how to change
the time that elapses before the printer enters the deep
sleep mode, refer to “Setting the Time that Elapses Before
Entering the Deep Sleep Mode” P.59.
Reference

●● For more detailed information on deep sleep mode, please
refer to the User’s Manual (Advanced).
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 Restoring a Printer from the
Power Saving Mode

Installing Options
This section explains how to install options on
your printer. The following options are available:
●● Additional RAM (256 MB or 512 MB)

Memo

●● 16 GB SD memory card kit

●● When the printer receives a print job from a computer or
other devices, it is restored automatically.

●● Wireless LAN module

Auto Power Off Function

Note

●● Be sure to turn off your printer and unplug the AC cord
and Ethernet or USB cable before installing options.
Installing options while your printer is turned on may
damage your printer and options.

When a certain period of time elapses after
printing, this printer will turn off automatically.
Memo

Memo

●● The factory default setting for time that elapses before the
printer power turns off automatically is 4 hours.

●● After installing options, set the option settings with a
printer driver. Refer to “When Adding Options” P.44.

●● For how to change the time that elapses before the
printer power turns off automatically, refer to “Settings for
Turning Power Off Automatically (Auto Power Off)” P.62.

Installing Additional RAM

Note

●● In the factory default setting, the auto power off mode
is disabled during network connection. To enable the
auto power off mode during network connection, refer to
“Settings for Turning Power Off Automatically (Auto Power
Off)” P.62.

Install additional RAM to increase the memory
capacity of your printer in cases such as if
memory overflow or the collate print errors occur.
Your printer supports 256 MB and 512 MB RAM.

Note

●● Use only genuine OKI products. The performance cannot
be guaranteed when using other products.
●● The static electricity may damage parts. Discharge the
static electricity from your body by touching grounded
metallic parts, etc., before work.
Memo

●● For banner printing, installing additional memory is
recommended.

1

Turn off your printer, and then unplug
the AC cord and Ethernet or USB cable.
Reference

●● “Turning Off the Power” P.22

2

Open the access cover (1) on the right
side of a printer.

1
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1. Setup

To restore the printer from the power save
mode or the deep sleep mode, press the
<POWER SAVE> button on the operator panel.

1

Preparing Your Printer

1

3

Slide the metal plate (2) upward to
remove.

5

Note

1. Setup

●● If the SD memory card socket is attached, remove
the SD memory card.

Insert the additional RAM (4) into the
slot and fix it by pushing it toward the
printer.
Note

●● Be sure to check a direction of an additional RAM.
The additional RAM has small dents on its connector,
which are fitted with a connector of a slot.

(1) Put your finger in the recess of the

metal plate (2), and slide it upward.

4

2

(2) Pinch the lower part of the metal

6

Install the metal plate (2).

(1) First, insert the upper part of the

plate (2), and pull it forward.

metal plate (2) in the printer, then
install the metal plate.

2
2

4

Make sure the LED (3) indicated by the
arrow turns off. If it is lit, wait until it
turns off.

(2) While holding the lower part of the

metal plate (2), slide the metal plate
downward and secure it.
2

3

Note

●● Attach the SD memory card socket before installing
the metal plate if the SD memory card socket was
attached to the printer.
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7

12 Press the scroll button

Close the access cover (1).

several times to
select [RAM] and press the <ENTER>
button.

1
1. Setup

1

13 Check that the value of [RAM] has
increased.

8

9

Plug the AC cord and Ethernet or USB
cable into your printer, and then turn on
the power switch.
Press the scroll button
operator panel.

or

RAM

on the

-- For memory expanded to 256 MB, it is
[512 MB]; for memory expanded to 512
MB, it is [768 MB].
Note

10 Press the scroll button

to select
[Configuration] and press the
<ENTER> button.

●● If the value of [RAM] has not increased, turn off
your printer and unplug the AC cord and Ethernet or
USB cable, and then reinstall the additional RAM.

14 Press the <ON LINE> button.

11 Press the scroll button

several times
to select [System] and press the
<ENTER> button.
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1

Installing the 16-GB SD Memory
Card Kit

3

Remove the metal plate (2) by sliding it
upward.

(1) Put your finger in the recess of the

1. Setup

For storing print data, install the SD memory
card kit.

metal plate (2), and slide it upward.

SD memory card
2

SD memory socket

(2) Pinch the lower part of the metal

Memo

plate (2), and pull it forward.

●● The SD memory socket is attached to the SD memory
card.
Note

●● Use only genuine OKI products. The performance cannot
be guaranteed when using other products.

2

●● The static electricity may cause damage to the parts.
Discharge the static electricity in your body by touching
grounded metallic parts, etc. before work.
●● You can not use the SD memory card with the protection
switch for accidental overwriting locked. Make sure to
release the lock.

1

Turn off your printer, and then unplug
the AC cord and Ethernet or USB cable.

4

Reference

●● “Turning Off the Power” P.22

2

Open the access cover (1).

Make sure the LED (3) indicated by the
arrow turns off. If it is lit, wait until it
turns off.

3
1
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5

(2) While holding the lower part of the

Install the SD memory card (4) into the
SD memory card socket (5).

metal plate (2), slide the metal plate
downward and secure it.

1. Setup

4
2

5

6

Install the SD memory socket to the
printer with the screw (6) and tab (7) for
the SD memory card socket and attach
the connector (8).

8

Close the access cover (1).

8

1

7

6

7

9

Plug the AC cord and Ethernet or USB
cable into your printer, and then turn on
the power switch.

10 Press the scroll button
operator panel.

Install the metal plate (2).

or

on the

(1) First, insert the upper part of the

metal plate (2) in the printer, then
install the metal plate.

2

11 Press the scroll button

to select
[Configuration] and press the
<ENTER> button.
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1

Preparing Your Printer

1

12 Press the scroll button

several times
to select [System] and press the
<ENTER> button.

Installing the Wireless LAN module

1. Setup

1

Turn off your printer, and then unplug
the AC cord.

2

Open the Wireless LAN module cover (1)
on the right side of a printer.

13 Press the scroll button

several times
to select [SD Card] and press the
<ENTER> button.
(1)

3
14 Check that the value of [SD Card] is
[16 GB].

SD Card
15GB[F52]

1/1

Note

●● [15 GB] may be displayed in [SD Card]. This is not
an error.
●● If the value of [SD Card] has not increased, turn off
your printer and unplug the AC cord and Ethernet or
USB cable, and then reinstall the SD memory card.

15 Press the <ON LINE> button.
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Pull out the connector, and plug it into
the Wireless LAN module.

Preparing Your Printer

4

Install the Wireless LAN module.

Test Printing from the Printer

Note

●● When a printer is in the power saving mode, press the
<POWER SAVE> button to restore from the mode.

5

1

Press the <Fn> key on the operator
panel.

2

Enter “100” using the numeric keypad
and press the <ENTER> button.

3

Press the <ENTER> button as
[Execute] is selected.

Close the Wireless LAN module cover.

Configuration
Execute

6

Plug the AC cord.

7

Turn on your printer while pressing the
<ENTER> button.

8

Press the <ENTER> button.

9

Enter the administrator password.

4

1/1

After finishing a print of printer settings,
a setup for printing from a printer
completes.
Reference

●● You can also print reports and lists for each function.
Refer to the User’s Manual (Advanced).

The factory default password is “999999”.

10 Press the scroll button

to select
[Wireless Module] and press the
<ENTER> button.

11 Press the scroll button

to select [Enable]
and press the <ENTER> button.

12 Press the <ON LINE> button.
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1. Setup

Check that you can print with the printer.
Check the detailed settings and status of your
printer by printing the contents of the settings
(Configuration).

1

Connecting to a Computer

Connecting to a Computer
1 ●●
1. Setup

This section explains how to connect your printer to a computer and install a printer driver software
using the provided “Software DVD-ROM”.
Prepare a computer with a DVD drive.

 Connection Method

You can select either of the following connection methods:
●● “Network Connection” P.31
●● “USB Connection” P.41

 Product Requirements

Your printer supports the following operating systems:
●● Windows 10/Windows 10 (64bit Version)
●● Windows 8.1/Windows 8.1 (64bit Version)
●● Windows 8/Windows 8 (64bit Version)
●● Windows 7/Windows 7 (64bit Version)
●● Windows Vista/Windows Vista (64bit Version)
●● Windows Server 2016
●● Windows Server 2012 R2
●● Windows Server 2012
●● Windows Server 2008 R2
●● Windows Server 2008/Windows Server 2008 (x64 Version)
●● OS X 10.8.5 to macOS Sierra
Depending on the printer driver version or the version of Windows or OS X, the description may be
different.
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Connecting to a Computer

Connecting in Wireless LAN
(Infrastructure Mode) (Optional)

Network Connection

Connecting an Ethernet Cable
Be sure to connect your printer to a network
with an Ethernet cable before driver installation.

1

Prepare an Ethernet cable (1) and a hub
(2).
Prepare an Ethernet cable (category 5, twisted
pair, straight) and a hub separately.
1

Note

●● In a wireless LAN environment, the machine enters sleep
mode, but does not enter deep sleep mode.
●● Do not place any devices (especially microwave
ovens or digital cordless telephones) that emit weak
electromagnetic waves near the machine.
●● Install the machine near a wireless LAN access point or
wireless device with no obstacles between them (the
distance should be within 30 m).
●● Wireless connections may be difficult if there is any metal,
aluminum framed windows, or reinforced concrete walls
between the machine and the wireless LAN access point.
●● Wireless LAN connections may have slower transmission
speeds, depending on the environment, than wired LAN
or USB connections. We recommend using a wired LAN or
a USB connection to print large amounts of data, such as
photographs.

2

2

Turn off your printer and computer.
Reference

●● “Turning Off the Power” P.22

3

Plug one end of the Ethernet cable into
the network interface connection (3) on
the back of the printer.

4

Plug the other end of the Ethernet cable
into the hub (2).

2

 To choose a valid default gateway
1

Press the scroll button several times
to select [Admin Setup] and press the
<ENTER> button.

2

Enter the administrator password using
the numeric (0-9) keys, and press the
<ENTER> button.
The factory default password is “999999”. Press
the <ENTER> button after each character you
input.

3

3

Press the scroll button several times
to select [Network Setup] and press
the <ENTER> button.

4

Press the scroll button several times
to select [Enabling Default Gateway]
and press the <ENTER> button.

5

Press the scroll button to select
[Wireless(Infrastructure)].

6

Press the <ENTER> button.
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1. Setup

Perform the following procedure to connect your
printer to a computer via network.

1

Connecting to a Computer

1

 Connecting Using WPS

1. Setup

If the wireless LAN access point supports WPS,
the connection to the wireless LAN can be made
easily by using the easy setup button (WPS
button).
Follow the procedure below for the setup.

1

2

Confirm the position of the easy setup
button and when to press the button
by referring to the user manual of the
wireless LAN access point.

Turn on the printer.

4

Press the scroll button several times
to select [Wireless(Infrastructure)
Setting], and then press the <ENTER>
button.
Enter the administrator password using
the numeric (0-9) keys, and press the
<ENTER> button.
The factory default password is “999999”. Press
the <ENTER> button after each character you
input.

6

7

If the wireless LAN access point does not support
WPS, you can connect by selecting the wireless
LAN access point you want to use from those the
machine has detected. To do this, an encryption
key is required.

1

Confirm that the wireless LAN access
point has been activated and is
functioning normally.

3

5

 Connecting by Selecting a
Wireless LAN Access Point from
the Control Panel

Press the scroll button several times
to select [Automatic setup (WPS)],
and then press the <ENTER> button.
Select [WPS-PBC], and then press the
<ENTER> button.

8

Select [Yes], and then press the
<ENTER> button.

9

The Printer starts searching for wireless
LAN access points. During 2 minutes,
press the easy setup button for the
wireless LAN access point for a few
seconds.

Confirm and write down the SSID and
encryption key by referring to the user
manual of the wireless LAN access point.
Memo

●● The SSID is also called the network name, ESSID, or
ESS-ID.
●● The encryption key is also called the network key,
security key, password, or pre-shared key.

2

Confirm that the wireless LAN access
point has been activated and is
functioning normally.

3

Turn on the printer.

4

Press the scroll button several times
to select [Wireless(Infrastructure)
Setting], and then press the <ENTER>
button.

5

Enter the administrator password using
the numeric (0-9) keys, and press the
<ENTER> button.
The factory default password is “999999”. Press
the <ENTER> button after each character you
input.

6

Press the scroll button several times to
select [Wireless Network Selection],
and then press the <ENTER> button.

7

The printer starts searching for wireless
LAN access points. Please wait.

8

A list of available wireless LAN access
point SSIDs are displayed. Press or ,
select a wireless LAN access point, and
press the <ENTER> button.

Once Connection successful is displayed,
it indicates that the wireless LAN setup has
completed.

Note

●● If only [Manual Setup] is displayed or the desired
wireless LAN network SSID is not displayed, follow
the procedure in “Connecting by Manual Setup from
Control Panel” to do the settings.

If Connection failed is displayed, repeat the
procedure from step 4.
If an antenna appears on the upper right corner
of the operator panel, it indicates that the
connection is successful.
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9

Memo

●● The encryption key differs depending on the wireless
LAN access point and security.

 Connecting by Manual Setup from
Control Panel
Configure the wireless LAN access point
information (SSID, encryption method, and
encryption key) manually, and connect to the
wireless LAN.

1

 If [WPA Pre-shared Key] is displayed
Item
Encryption
method
Encryption key

Explanation
WPA/WPA2-PSK

Note

●● When the encryption method is WPA-EAP or WPA2EAP, configure from the printer’s web page.

Enter the pre-shared key.

Memo

* Configure from the machine’s web page.

●● The SSID is also called the network name, ESSID, or
ESS-ID.

 If [WEP Key] is displayed
Item
Encryption
method
Encryption key

Encryption
method
Encryption key

●● The encryption key is also called the network key,
security key, password, or pre-shared key.

Explanation
WEP
Input the WEP key.

 Other settings
Item

Check and write down the SSID, the
encryption method and the encryption
key by referring to the user manual of
the wireless LAN access point.

Explanation
Disable

2

Confirm that the wireless LAN access
point has been activated and is
functioning normally.

3

Turn on the printer.

4

Press the scroll button several times
to select [Wireless(Infrastructure)
Setting], and then press the <ENTER>
button.

5

Enter the administrator password using
the numeric (0-9) keys, and press the
<ENTER> button.

Input is not necessary.

10 The SSID selected in step 7 and the

encryption method in step 8 are displayed
as security in of the confirmation screen.
If the SSID is the same as the one set up
in step 1, select [ENTER]:Execute and
press the <ENTER> button.

Once Connection successful is displayed,
it indicates that the wireless LAN setup has
completed.
If Connection failed is displayed, repeat the
procedure from step 4.
If an antenna appears on the upper right corner
of the operator panel, it indicates that the
connection is successful.

The factory default password is “999999”. Press
the <ENTER> button after each character you
input.

6

Press the scroll button several times to
select [Wireless Network Selection],
and then press the <ENTER> button.

7

The printer starts searching for wireless
LAN access points. Please wait.

8

A list of available wireless LAN access
point SSIDs are displayed. Press or ,
select [Manual Setup] at the end of the
list, and press the <ENTER> button.

9

Input the SSID recorded in step 1, and
press the <ENTER> button.
Note

●● It is case sensitive. Please enter it correctly.
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1
1. Setup

A screen opens in which to input the
encryption key appropriate to the
encryption procedure for the selected
wireless LAN access point; input the
encryption key.

Connecting to a Computer

1

10 Select the encryption method confirmed
in step 1, and press the <ENTER>
button.
Memo

1. Setup

●● The encryption key differs depending on the wireless
LAN access point and security.

11 Input the encryption key recorded in

step 1, and press the <ENTER> button.

12 Press the <ENTER> button.
Once Connection successful is displayed,
it indicates that the wireless LAN setup has
completed.
If Connection failed is displayed, repeat the
procedure from step 4.
If an antenna appears on the upper right corner
of the operator panel, it indicates that the
connection is successful.

Installing a Printer Driver
(for Windows)
To complete the network connection with a
Windows computer, first set IP addresses for the
printer, and then install a printer driver on the
computer.
If there is no DHCP server or BOOTP server on
the network, you need to manually configure the
IP address on the computer or printer.
If your network administrator or internet service
provider specifies an unique IP address for the
computer and your printer, you need to set the
IP addresses manually.
Note

●● You need to complete the network setting of the computer
before this procedure.
●● To complete this procedure, you must be logged in as an
administrator.
●● When setting an IP address manually, ask the network
administrator or your internet service provider which
IP address to use. If the IP address is set wrong, the
network may go down or Internet access may be disabled.
Memo

●● If configuring a small network consisting of only your
printer and a computer, set IP addresses as shown below
(according to RFC1918).
For the computer
IP address :

192.168.0.1 - 254

Subnet mask :

255.255.255.0

Default gateway :

not used

DNS server :

not used

For the printer
IP address Set :

Manual

IP address:

192.168.0.1 - 254 (select a
different value from that of the
computer)

Subnet Mask :

255.255.255.0

Default Gateway :

0.0.0.0

Network Scale :

Small

●● To set [Network Scale], press the scroll button
or
and then select [Admin Setup] > [Network Setup] >
[Network Scale].
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First, Set the IP address of the printer.

1

Turn on the printer.

2

Press the

Press the to select [IP Address Set],
and press the <ENTER> button.

8

If setting the IP address manually, press
the scroll button and select [Manual],
and press the <ENTER> button.

button on the operator panel.

Press the scroll button to select [Admin
Setup], and press the <ENTER> button.

After entering all settings, press the <BACK>
button.
Proceed to the step 9.

4

Enter the administrator password using
the numeric (0-9) keys, and press the
<ENTER> button.

If obtaining the IP address automatically, check
that [Auto] is selected, and press the <ENTER>
button.

The factory default password is “999999”. Press
the <ENTER> button after each character you
input.

After entering all settings, press the <BACK>
button.
Proceed to the step 15.

5

Press the <ENTER> button.

9

6

1
1. Setup

3

7

Check that [Network Setup] is selected
and press the <ENTER> button.
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Press the scroll button to select
[IPv4 Address], and press the
<ENTER> button.

Connecting to a Computer

1

10 Enter the IP address using the numeric
(0-9) keys, and press the <ENTER>
button.

14 Enter the default gateway address and
press the <ENTER> button.

To move to the next box, press the <ENTER>
button.

1. Setup

To move to the next box, press the <ENTER>
button.

After entering all settings, press the <BACK>
button.

After entering all settings, press the <BACK>
button.

Gateway Address
192 . 168.
0. 254

11 Press the scroll button

to select
[Subnet Mask], and press the
<ENTER> button.

15 When the setup menu screen is

displayed, press the <ON LINE> button
to complete the network settings.

12 Enter the subnet mask in the same
manner of IP address.

To move to the next box, press the <ENTER>
button.
After entering all settings, press the <BACK>
button.

13 Press the scroll button

to select
[Gateway Address], and press the
<ENTER> button.
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7

Next, install the printer driver on the
computer.
Insert the included “Software DVD-ROM”
into a computer.

2

When [AutoPlay] is displayed, click
[Run Setup.exe].

Installation starts.
Memo

●● The following software is installed.
-- PS Printer Driver (Including Network Extension)
●● Install other software from Custom Install

8

Make sure that the software is
successfully installed, and then click
[Printing Test].

9

Click [Complete].

Memo

●● If the [User Account Control] dialog box is
displayed, click [Yes].

3

Select a language from the drop-down
list.

4

Read the license agreement, and then
click [Accept].

5

Select [Network (Wired/Wireless)]
in accordance to the connection method
of the machine and computer, and then
click [Next].

6

Select the model name of the machine,
and then click [Next].

1
1. Setup

1

Click [Install Optional Software].

10 Click [Next].
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1

11 Click [Exit].

Click [+].

9

Click [Default].

1. Setup

8

Installing a Printer Driver
(For OS X)

10 Select the machine where [Kind]

is [Bonjour], and then select [Oki
Pro8432WT PS] from the [Use].

To complete the network connection with a Mac
operating system, install a printer driver on the
computer and set your printer as a network
printer.

Connection
Network

Note

●● Disable the anti-virus software before starting this
procedure.

Priner Name

OKI-Pro8432WT-(last 6 digits Bonjour
of MAC address)

Memo

●● To change the name, enter a new name into
[Name:].

 Install the OS X PS Printer Driver.
When the installation is complete, print a test
page in step 14.

1

Make sure that the machine and a
computer are connected and the
machine is turned on.

2

Insert the “Software DVD-ROM” into a
computer.

3

Double-click the [OKI] icon on the
desktop.

4

[Drivers] > Double-click [Installer for
OSX].

5

Enter the administrator password, and
then click [OK].

11 Click [Add].
12 When [Installable options] is
displayed, click [Continue].

Follow the on-screen instructions to complete the
installation.

6

Select [System Preferences] from the
Apple menu.

7

Click [Printers & Scanners].
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Kind

Connecting to a Computer

13 Make sure that the machine is added

to [Printers] and [Pro8432WT PS] is
displayed for [Kind].

Connecting in Wireless LAN (AP
Mode) (Optional)

Note

●● You cannot enable wireless LAN (infrastructure) and
wireless LAN (AP mode) at the same time.
●● If you enable wireless LAN (AP mode), the machine enters
sleep mode, but does not enter deep sleep mode.

Note

●● If [Pro8432WT PS] is not displayed for [Kind]
correctly, click [-], delete the machine from
[Printers], and then newly perform steps 8 to 12.

14 Click [Open Print Queue...].
15 Select [Print Test Page] from the
[Printer] menu.

●● Do not place any devices (especially microwave
ovens or digital cordless telephones) that emit weak
electromagnetic waves near the machine.
●● Wireless connections may be difficult if there is any
metal, aluminum framed windows, or reinforced concrete
walls between the machine and the wireless terminal
(computer, tablet, smartphone, etc.).
●● Wireless LAN connections may have slower transmission
speeds than wired LAN or USB connections, depending on
the environment. We recommend using a wired LAN or a
USB connection.

 Preparing to use the wireless LAN
(AP mode)
The machine becomes a simple wireless access
point, and wireless terminals (computer, tablet,
smartphone, etc.) can connect directly to it.
Before you start, confirm that the wireless
device you are using supports the following
environment.
Item
Standard
Security
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Value
IEEE 802.11 b/g/n
WPA2-PSK (AES)

1. Setup

The wireless LAN (AP mode) connects directly
to a wireless terminal (computer, tablet,
smartphone, etc.) without using a wireless LAN
access point.

1

Connecting to a Computer

1

 Automatic Setup (Push Button)

 Manual connections

1. Setup

If the wireless terminal (computer, tablet,
smartphone, etc.) supports WPS-PBC (push
button), then you can use the WPS button to
connect via wireless (AP mode).

If the wireless terminal (computer, tablet,
smartphone, etc.) does not support WPS-PBC
(push button), then you can input the machine’s
SSID and password into the wireless terminal
(computer, tablet, smartphone, etc.) to connect.

Follow the procedure below to connect.

1

Follow the procedure below to connect.

Confirm the position of the WPS
button in the user’s manual provided with
the wireless terminal (computer, tablet,
smartphone, etc.)

2

Turn on the printer.

3

Press the scroll button several times to
select [Wireless(AP Mode) Setting],
and then press the <ENTER> button.

4

Enter the administrator password using
the numeric (0-9) keys, and press the
<ENTER> button.

1

Turn on the printer.

2

Press the scroll button several times to
select [Wireless(AP Mode) Setting],
and then press the <ENTER> button.

3

Enter the administrator password using
the numeric (0-9) keys, and press the
<ENTER> button.
The factory default password is “999999”. Press
the <ENTER> button after each character you
input.

The factory default password is “999999”. Press
the <ENTER> button after each character you
input.

5

Select [Enable], and then press the
<ENTER> button.

6

Press the scroll button to select
[Automatic Setup (Push Button)],
and then press the <ENTER> button.

7

Select [Yes], and then press the
<ENTER> button.

8

Start WPS-PBC (push button) on the
wireless terminal (computer, tablet,
smartphone, etc.).

4

Select [Enable], and then press the
<ENTER> button.

5

Press the scroll button several times
to select [Manual Setup], and then
press the <ENTER> button.

6

Confirm the [SSID] and [Password]
that are displayed on the printer.

7

Input the printer’s [SSID] and
[Password] that were confirmed
in step7 for the wireless terminal
(computer, tablet, smartphone, etc.).
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Connecting to a Computer

USB Connection

Connecting a USB Cable
1

Note

●● You must be logged in as an administrator to complete
this procedure.

1

Insert the included “Software DVD-ROM”
into a computer.

2

When [AutoPlay] is displayed, click
[Run Setup.exe].

Prepare a USB cable (1).
A USB cable is not supplied with your printer.
Prepare a USB 2.0 cable separately.
1

Memo

●● Use a USB 2.0 Hi-Speed cable for a USB 2.0 HiSpeed connection.

2

Turn off your printer and the computer.
Reference

●● “Turning Off the Power” P.22

3

Plug one end of the USB cable into the
USB interface connector (2) on the back
of the printer.

4

Plug the other end of the USB cable into
the computer’s USB interface connector.

1

Memo

●● If the [User Account Control] dialog box is
displayed, click [Yes].

3

Select a language from the drop-down list.

4

Read the license agreement, and then
click [Accept].

5

Select [USB] in accordance to the
connection method of the machine and
computer, and then click [Next].

6

Select the model name of the machine,
and then click [Next].

2

Note

●● Do not plug the USB cable into the network interface
connection. Doing so may cause a malfunction.
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1. Setup

Perform the following procedure to connect your
printer to a computer via USB.

Installing a Printer Driver
(For Windows)

Connecting to a Computer

1

7

Click [Install Optional Software].

1. Setup

11 Click [Exit].

Installation starts.
Memo

●● The following software is installed.
-- PS Printer Driver
●● Install other software from Custom Install.

8

9

Make sure that the software is
successfully installed, and then click
[Printing Test].

Installing a Printer Driver
(For OS X)

Click [Complete].

Note

●● Disable the anti-virus software before starting this
procedure.

 Install the OS X PS Printer Driver.
When the installation is complete, print a test
page in step 14.

10 Click [Next].

1

Make sure that the machine and a
computer are connected and the
machine is turned on.

2

Insert the “Software DVD-ROM” into a
computer.

3

Double-click the [OKI] icon on the
desktop.

4

[Drivers] > Double-click [Installer for
OSX].

5

Enter the administrator password, and
then click [OK].
Follow the on-screen instructions to complete the
installation.

Note

●● The following screen may appear when [Next] is clicked.

6

Select [System Preferences] from the
Apple menu.

7

Click [Printers & Scanners].

●● If it appears, click [Yes].
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Connecting to a Computer

8

Click [+].

13 Make sure that the machine is added

9

Click [Default].

to [Printers] and [Pro8432WT PS] is
displayed for [Kind].

1
1. Setup

Note

10 Select the machine where [Kind]

●● If [Pro8432WT PS] is not displayed for [Kind]
correctly, click [-], delete the machine from
[Printers], and then newly perform steps 8 to 12.

is [USB], and then select [Oki
Pro8432WT PS] from the [Use].

Connection
USB

Priner Name
OKI DATA CORP Pro8432WT

Kind
USB

14 Click [Open Print Queue...].
15 Select [Print Test Page] from the
[Printer] menu.

Memo

●● To change the name, enter a new name into
[Name:].

11 Click [Add].
12 When [Installable options] is
displayed, click [Continue].
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Connecting to a Computer

1

When Adding Options

1. Setup

4

Select the [Options] tab.

5

Change the setting according to the
added options.

If options such as SD memory card kit has been
installed, use following procedures to change
printer driver settings.

 For Windows PS Printer Driver
1

Click [Start] > [Devices and Printers].

2

Right-click the [Pro8432WT] icon
and then select [Printer Properties].
(If you have installed multiple printer
drivers, select [Printer Properties] >
[Pro8432WT PS].)

3

Select the [Device Settings] tab.

4

If using a network connection, select
[Get installed options automatically]
under [Installable Options], and then
click [Setup]. If using a USB connection,
change the setting according to the
added options of [Installable Options].

5

Click [OK].

 For OS X PS Printer Driver
1

Select [System Preferences] from the
Apple menu.

2

Click [Printers & Scanners].

3

Select the name of your printer and then
click [Options & Supplies].
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2. Printing Basic Operation
This chapter describes how to print documents from a computer.

2

●●
Supported Paper
For high-quality printing, be sure to use paper types that satisfy requirements such as those for
material quality, weight, and surface finish. Please use digital photo print paper.
If not using recommended paper, please check the print quality and the movement of the paper
sufficiently beforehand to make sure that there are no problems. Your printer supports the following
types of paper.
Paper Type
Plain paper

Paper Size mm (inch)
A3
A4
A5
A6
B4
B5
B6
B6 Half
Tabloid
Letter
Legal 13"
Legal 13.5"
Legal 14"
Executive
Statement
8.5"SQ
Folio
8K (260 x 368 mm)
8K (270 x 390 mm)
8K (273 x 394 mm)
16K (184 x 260 mm)
16K (195 x 270 mm)
16K (197 x 273 mm)
Custom Size

Index card

Index card

Photo

Photo (4 x 6 inch)
Photo (5 x 7 inch)

297 x 420
210 x 297
148 x 210
105 x 148
257 x 364
182 x 257
128 x 182
64 x 182
(11 x 17)
215.9 x 279.4
(8.5 x 11)
215.9 x 330.2
(8.5 x 13)
215.9 x 342.9
(8.5 x 13.5)
215.9 x 355.6
(8.5 x 14)
184.2 x 266.7
(7.25 x 10.5)
(5.5 x 8.5)
(8.5 x 8.5)
210 x 330.2
260 x 368
270 x 390
273 x 394
184 x 260
195 x 270
197 x 273
Width:
64 - 297
Length:
90 - 431
76.2 x 127
(3 x 5)
(4 x 6)
(5 x 7)
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Paper Weight
64 to 256 g/m2
Note

●● If the paper size is set at A6, A5, or
with a paper width narrower than 148
mm (A5 width), the printing will be
slower.

64 to 256 g/m2

2. Printing Basic Operation

Supported Paper Types

Supported Paper

Use paper that meets the following conditions*1:
●● Paper that meets the conditions for plain paper.
●● An ink used for a part printing is heat resistant (230°C).

2

Note

●● When specifying a printing area, please take into account the differences of printing position as followings:
Print start position: ±2 mm, Paper skew: ±1 mm/100 mm, Image stretch: ±1 mm/100 mm
(when paper weight is 80g/m2)

2. Printing Basic Operation

●● This printer cannot print on an ink.

Use paper that meets the following conditions*2:
●● A pigment or an ink used to color paper is heat resistant (230°C).
●● Paper that has same characteristics with light paper and used for an electronic photo printer.

Paper Recommendations

Storing Paper

Your printer will handle a variety of print media,
including a range of paper weights and sizes.

Store paper under the following conditions to
maintain quality.

This section provides general advice on choice of
media, and explains how to use each type.

●● Inside a cabinet or other dry and dark place

The best performance will be obtained when
using standard 75 - 90 g/m2 paper designed for
use in copiers and laser printers.

●● Temperature: 20°C

Use of heavily embossed or very rough textured
paper is not recommended.
Pre-printed stationery can be used, but the ink
must not offset when exposed to the high fuser
temperatures used in the printing process.

CAUTION
●● Envelopes should be free from twist, curl or
other deformations. They should also be of the
rectangular flap type, with glue that remains
intact when subjected to hot roll pressure fusing
used in this type of printer. Window envelopes are
not suitable.
●● Labels should also be of the type recommended
for use in copiers and laser printers, in which the
base carrier page is entirely covered by labels.
Other types of label stock may damage the printer
due to the labels peeling off during the printing
process.

●● On a flat surface
●● Humidity: 50% RH (relative humidity)
Do not store in the following locations.
●● Directly on the floor
●● In direct sunlight
●● Near the inside of an exterior wall
●● On an uneven surface
●● Where static electricity may be generated
●● In places that are excessively hot or where
temperature rapidly changes
●● Near a copier, air conditioner, heater, or duct
Note

●● Do not unwrap the paper until you are ready to use the
paper.
●● Do not leave paper unwrapped for a long period. Doing
so may result in paper handling and print quality issues.
●● Depending on a media you use, usage conditions and a
storing conditions, a decrease in paper quality or curling
of the paper may occur.
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Supported Paper

Paper Loaded on the Tray
Your printer has two built-in trays (tray 1 and the MP tray). Refer to the list below to check the
supported paper and capacities of each tray.
Tray
Tray1

Paper capacity
300 sheets
(when paper weight is 80 g/m2)

Paper weight
●● Light
(64 to 82 g/m2)
●● Medium Light
(83 to 90 g/m2)
●● Medium
(91 to 105 g/m2)
●● Heavy
(106 to 128 g/m2)
●● Ultra Heavy1
(129 to 188 g/m2)
●● Ultra Heavy2
(189 to 220 g/m2)

●● 100 sheets
●● Light
(when paper weight is 80 g/m2)
(64 to 82 g/m2)
●● Medium Light
(83 to 90 g/m2)
●● Medium
(91 to 105 g/m2)
●● Heavy
(106 to 128 g/m2)
●● Ultra Heavy1
(129 to 188 g/m2)
●● Ultra Heavy2
(189 to 220 g/m2)
●● Ultra Heavy3
(221 to 256 g/m2)
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2
2. Printing Basic Operation

MP Tray

Supported paper size
●● A3
●● A4
●● A5
●● A6
●● B4
●● B5
●● B6
●● Tabloid
●● Letter
●● Legal 13”
●● Legal 13.5”
●● Legal 14”
●● Executive
●● Statement
●● 8.5”SQ
●● Folio
●● 8K (260 x 368 mm)
●● 8K (270 x 390 mm)
●● 8K (273 x 394 mm)
●● 16K (184 x 260 mm)
●● 16K (195 x 270 mm)
●● 16K (197 x 273 mm)
●● Custom Size
●● A3
●● A4
●● A5
●● A6
●● B4
●● B5
●● B6
●● B6 Half
●● Tabloid
●● Letter
●● Legal 13”
●● Legal 13.5”
●● Legal 14”
●● Executive
●● Statement
●● 8.5”SQ
●● Folio
●● 8K (260 x 368 mm)
●● 8K (270 x 390 mm)
●● 8K (273 x 394 mm)
●● 16K (184 x 260 mm)
●● 16K (195 x 270 mm)
●● 16K (197 x 273 mm)
●● Index Card
●● Photo (4 x 6 inch)
●● Photo (5 x 7 inch)
●● Custom Size

How to Print from the Tray

●●
How to Print from the Tray
The following procedure explains how to load paper in tray 1.
Memo

2

●● This procedure explains to load paper in tray 1.

1

Pull out the paper tray (1).

Note

2. Printing Basic Operation

●● When loading A6 size paper, move the paper stopper
(4) forward and remove it once, then install it on the
metal part.
4

1

2

4

Flex paper back and forth, and then fan
it. Straighten the edges of the paper
stack on a level surface.

5

Load paper with the print side face down
and press it from above.

Set the paper size dial (2) to match the
size of the paper to be loaded.
Set the dial to [A4
] when loading A4 size
paper in horizontal orientation.

2

Note

●● Do not load paper exceeding the [
paper guide.

] mark (5) of the

5

3

Slide the paper guide (3) and paper
stopper (4) to the size of paper to be
loaded.

6

Secure the loaded paper with the paper
guide.

7

Check if a size of loaded paper matches
the setting of paper size dial.

8

Return the paper tray to the printer.
Memo

●● If loading a paper that you cannot select the
size with a paper size dial options, set the dial to
[Other], and then set a paper size on the operator
panel.

4
3

9
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Open a file you want to print, and print it.

How to Print from the MP Tray

●●
How to Print from the MP Tray
This procedure explains how to load paper in the MP tray.
Note

●● Do not load paper of different sizes, types or weights at the same time.
●● When adding paper, remove the paper on the MP tray and straighten the edges of both stacks of paper, and then load them
again.

1

4

Open the MP tray (1) forward by
inserting your fingers into the front
recesses (2).

Open the paper set cover (5).
5

2

1

2

5

2

Adjust the manual feeding paper guide
(6) to the width of paper to be loaded.

Pull out the paper support (3) by holding
the center part of it.

3

6

6

Insert the paper with the print side face
up.
Note

3

●● Do not load paper exceeding the [
paper guide.

Unfold the sub support (4).

7

4
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] mark (7) of the

2. Printing Basic Operation

●● Do not put anything other than paper for printing in the MP tray.

2

How to Print from the MP Tray

10 When [Paper Size] is displayed, select

Note

the size of the loaded paper and then
press the <ENTER> button.

●● The paper may be wrinkled or curled after printing.
●● Use paper stored in proper temperature and humidity
conditions. Do not use paper that is curled or waved
because of humidity.

2

●● Do not print on the back side of paper on which other
printer has printed.

2. Printing Basic Operation

●● Curling of a postcard or an envelope may cause the ink
absorbing problem. Use paper that is not curled. Correct a
paper Curling within 2 mm.

7

Close the paper set cover (5).
Reference

●● If [Custom] is selected for [Paper Size], you need
to register the custom size. For how to register the
custom size, refer to “Printing in Custom Sizes”
P.52.

5

11 Press the <BACK> button until
[MPTray Config] is displayed.

If always printing on same size or type paper
from the MP tray, register the paper on the
operator panel. If printing once, proceed to the
step 18.
Note

●● When a printer is in the power saving mode, press
the <POWER SAVE> button to restore from the
mode.

12 Press the scroll button

to select
[Media Type] and then press the
<ENTER> button.

●● Make sure that the message “Ready To Print” is
displayed in the operator panel. If the message is not
displayed, press the <ON LINE> button.

8

9

Press the <Fn> key.

13 Press the scroll button

to select the
type of the loaded paper and then press
the <ENTER> button.

Enter “90” using the numeric keypad
and then press the <ENTER> button.
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How to Print from the MP Tray

14 Press the <BACK> button to display the
[MPTray Config].

to select
[Media Weight] and then press the
<ENTER> button.

1

From the [File] menu, select [Print].

2

Click [Preferences] or [Properties].

3

Select the [Paper/Quality] tab.

4

Select [Multi-Purpose Tray] from
[Paper Source].

5

Click [Advanced].

6

Click [Paper Size] and select a paper
size from the drop-down list.

7

Click [OK].

8

Start printing.

For OS X PS Printer Driver
16 Press the scroll button

to select the
weight of the loaded paper and then
press the <ENTER> button.

1

From the [File] menu, select [Print].

2

Select the paper size from [Paper Size].

3

Select [Paper Feed] from the panel
menu.

4

Select [All pages From] and then select
[Multi-Purpose Tray].

5

Start printing.
Memo

17 Press the <ON LINE> button to exit the
menu mode.

18 Open the file you want to print, and print
it by following the procedures below.
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●● If setting details are not displayed in the print dialog
box for OS X, click [Show Details] at the bottom of
the dialog box.

2
2. Printing Basic Operation

15 Press the scroll button

For Windows PS Printer Driver

Printing in Custom Sizes

●●
Printing in Custom Sizes
To load custom size paper, you need to register the width and length of the paper before printing. The
range of the sizes you can set differs according to the paper tray.

2

Tray
Tray1

2. Printing Basic Operation

MP tray

Available size range

4

Press the scroll button several times
to select [Tray Config] of the paper
tray in which you loaded paper and then
press the <ENTER> button.

5

Check that [Paper Size] is selected and
press the <ENTER> button.

6

Press the scroll button several times
to select [Custom] and then press the
<ENTER> button.

7

Press the <BACK> button.

Width:
105 to 297 mm (4.1 to 11.7 inches)
Length:
148, 182 to 431 mm
(5.8, 7.2 to 17.0 inches)
Width:
64 to 297 mm (2.5 to 11.7 inches)
Length:
90 to 431 mm (3.5 to 17.0 inches)

Note

●● [Custom] is displayed only when [Paper Size] is set to
[Custom].

1

Press the scroll button
operator panel.

or

on the

2

Press the scroll button several times
to select [Menus] and press the
<ENTER> button.

3

Check that [Tray Configuration]
is selected and press the <ENTER>
button.
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Printing in Custom Sizes

8

Press the scroll button to select
[X Dimension] and then press the
<ENTER> button.

13 Press the <ON LINE> button to exit the
menu mode.

2

Enter the paper width value using the
numeric keypad and then press the
<ENTER> button.

10 Press the <BACK> button.

14 Specify a custom in the following
procedures.

For Windows PS Printer Driver
1

Click [Start] and select [Devices and
Printers].

2

Right-click the Your Printer icon and
select the type of driver you want to
specify from [Printing preferences].

3

On the [Layout] tab, click [Advanced].

4

Click [Paper Size] and select
[PostScript Custom Page Size] from
the drop-down list.

5

Enter the dimensions in the [Width] and
[Height] boxes, and press [OK].
Note

●● [Offsets Relative to Paper Feed Direction] is not
available.

11 Press the scroll button

to select
[Y Dimension] and then press the
<ENTER> button.

6

Press [OK] until the [Printing
preferences] dialog box is closed.

7

Open the file you want to print from the
application.

8

Select [PostScript Custom Page Size]
for a paper size and start printing on the
printer driver.

12 Enter the paper length value using the
numeric keypad and then press the
<ENTER> button.
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2. Printing Basic Operation

9

Printing in Custom Sizes

For OS X PS Printer Driver

For OS X PS Printer Driver

Note

2

●● In the OS X printer driver, paper size out of the available
range can be set, however, image is not correctly printed.
set paper size within available range.

1

From the [File] menu, select [Print].

2

Select the paper size from [Paper Size].

2. Printing Basic Operation

1

Open the file you want to print.

3

2

From the [File] menu, select [Page
Setup].

Select [Paper Feed] from the panel
menu.

4

3

Select [Manage Custom Sizes] from
[Paper Size]

Select [All pages From] and then select
[Multi-Purpose Tray].

5

Start printing.

4

Click [+] to add an item to the list of
custom paper sizes.

5

Double-click [Untitled] and enter a
name for the custom paper size.

6

Enter the dimensions in the [Width] and
[Height] boxes.

7

Click [OK].

8

Click [OK].

9

From the [File] menu, select [Print].

Memo

●● If setting details are not displayed in the print dialog
box for OS X, click [Show Details] at the bottom of
the dialog box.

10 Configure other settings if necessary and
then start printing.

Open the file you want to print, and print
it in the following procedures.

For Windows PS Printer Driver
1

From the [File] menu, select [Print].

2

Click [Preferences] or [Properties].

3

Select the [Paper/Quality] tab.

4

Select [Multipurpose Tray] from
[Paper Source].

5

Click [Advanced].

6

Click [Paper Size] and select a paper
size from the drop-down list.

7

Click [OK].

8

Start printing.
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Paper Output

●●
Paper Output
Your printer outputs to the output tray or rear output tray. Paper types that can be outputted to each
stacker are as follows.
Supported
paper type

Paper output
capacity

Output
Tray

●● Plain paper
●● Recycled
paper

●● 200 sheets (when
paper weight is less
than 80 g/m2)

Rear
Output
Tray

●● Plain paper
●● Recycled
paper
●● Index card

●● 100 sheets (when
paper weight is less
than 80 g/m2)
●● 10 sheets (Ultra
Heavy paper and
envelopes)

 Using the Rear Output Tray

2

1

2. Printing Basic Operation

Output
Stacker

Paper is delivered with the print side face up,
stacked opposite the order printed.

Pull the rear output tray (1) on the rear
side of the printer and open it outward.
1

Note

●● Do not open or close the rear output tray while printing as
it may result in a paper jam.

 Using the Output Tray

2

Paper is delivered with the print side face down,
stacked in the order printed.

Unfold the paper support (2).

Note

●● Check that the rear output tray (1) on the rear side of the
printer is closed. If the rear output tray is open, paper is
always outputted to the rear output tray.

2

3

Open the sub support (3).
3

1

Memo

●● Open the paper supporter (2) so that the printed papers
do not fall down from the output tray.

2
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Convenient Print Functions

●●
Convenient Print Functions
The following convenient print functions are available. For details, refer to the User’s Manual
(Advanced).

2

 Printing on Custom Size Paper

2. Printing Basic Operation

You can register customized paper sizes to the
printer driver so you can print on nonstandard
paper such as banners.
● Printing on custom size paper
A3
A4

 Changing the Page Layout

You can change the page layout to multiple print.
●Multipie print

1

2

3

4

 Scaling to Pages

You can print data formatted for one size page
onto a different size page without modifying the
print data.

 Changing Print Quality
(Resolution)

You can change the print quality to suit your
needs.

Memo

●● There are many convenient print functions in addition to
those above. Refer to the User’s Manual (Advanced).
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Canceling Printing

●●
Canceling Printing
Press the <CANCEL> button on the operator
panel to cancel print jobs being currently printed
or preparing for a print.

2
2. Printing Basic Operation

When you press the <CANCEL> button is
pressed, the following message appears.

To cancel printing, select [Yes] and then press

the <ENTER> button.

To proceed to printing, select [No] and then

press the <ENTER> button.

If a printer is not operated for about 3 minutes
while this message appears, the message will go
out and printing proceeds.
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Setting the Time that Elapses Before Entering the Power Save Mode

●●
Setting the Time that Elapses Before Entering the
Power Save Mode
Note

2

●● When a printer is in the power saving mode, press the <POWER SAVE> button to restore from the mode.
●● Check if the message “Ready To Print” appears. If the message is not displayed, press the <ON LINE> button.

2. Printing Basic Operation

1

Press the <Fn> key on the operator
panel.

Memo

●● The power save time can be selected from the followings:
--[1 minute]
--[2 minutes]
--[3 minutes]
--[4 minutes]
--[5 minutes]
--[10 minutes]
--[15 minutes]

2

Enter “200” using the numeric keypad
and then press the <ENTER> button.

3

Press the scroll button or to specify
the time and then press the <ENTER>
button.

4

Press the <ON LINE> button.

--[30 minutes]
--[60 minutes]
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Setting the Time that Elapses Before Entering the Deep Sleep Mode

●●
Setting the Time that Elapses Before Entering the
Deep Sleep Mode
Note

●● When a printer is in the deep sleep mode, press the <POWER SAVE> button to restore from the mode.
●● Check if the message “Ready To Print” appears. If the message is not displayed, press the <ON LINE> button.

Press the <Fn> key on the operator
panel.

Memo

●● The sleep time can be selected from the followings:
--[1 minute]
--[2 minutes]
--[3 minutes]
--[4 minutes]
--[5 minutes]
--[10 minutes]
--[15 minutes]

2

Enter “201” using the numeric keypad
and then press the <ENTER> button.

3

Press the or to specify the time and
then press the <ENTER> button.

4

Press the <ON LINE> button.

--[30 minutes]
--[60 minutes]
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2. Printing Basic Operation

1

2

Setting the Time that Elapses Before Entering the Deep Sleep Mode

Constraints When in Deep Sleep Mode
This section explains constraints when in the deep sleep mode.
The printer may not enter the deep sleep mode if an error is displayed.

2

Printer Driver Utility Constraints

2. Printing Basic Operation

When the printer goes into the deep sleep mode, the following constraints apply to the printer driver
and utility functions.
When the printer goes into the deep sleep mode, press the <POWER SAVE> button on the control
panel and check that the screen displays the message “Ready To Print”.
If the message “Ready To Print” is displayed, the following constraints do not apply.

OS
Windows

Software Name
Driver Installer

Constraints When in the
Deep Sleep Mode
If there is a connection with the
network, you cannot automatically
get printer option information
when installing a driver.
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Method of resolving
other than to press the
<POWER SAVE>
button
-

Setting the Time that Elapses Before Entering the Deep Sleep Mode

Network Function Constraints
In the deep sleep mode, the following
constraints apply to network functions.

 Does Not Enter the Deep Sleep
Mode

●● IPSec is enabled.

In the deep sleep mode, the following protocols
with client functions will not work.
●● E-mail alerts*1
●● SNMP Trap
●● WINS*2
●● SNTP*3

●● A TCP connection is established.

*1 Time that passes in the deep sleep mode is not included in the
interval for periodic notification by e-mail alert.

E.g.: A connection is established with Telnet or
FTP.

*2 Time that passes in the deep sleep mode is not included in the
intervals between WINS updates. Regular WINS updates are not
carried out in the deep sleep mode, so the names registered on the
WINS server may be deleted.

When the transition time to enter Deep Sleep
mode from Power Save mode elapses and the
connection is disconnected, the machine enters
Deep Sleep mode.

*3 Time that passes in the deep sleep mode is not included in the
interval between update for NTP servers.

●● E-mail reception is enabled.
●● Wireless LAN is enabled.
●● LLTD is enabled.
●● HUB Link Status is 1000BASE-T.
●● IPv6 Global Address is assigned.

 Cannot Print

In the deep sleep mode, you cannot print with
the following protocols.
●● NBT

 Cannot Search/Cannot Specify
Settings

In the deep sleep mode, you cannot search or
specify settings with the following functions or
protocols.
●● NBT
●● PnP-X
●● UPnP
●● MIB*
* You can reference through some supported MIB in the deep sleep
mode (Get command).
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In the following cases, a printer will not enter
the deep sleep mode.

 Protocols with the Client
Functions Do Not Work

Settings for Turning Power Off Automatically (Auto Power Off)

●●
Settings for Turning Power Off Automatically
(Auto Power Off)
Note

2

●● In the factory default, a printer does not enter the auto power off mode while connecting to the network.

Setting the Auto Power Off
2. Printing Basic Operation

5

Press the scroll button several times
to select [Power Setup], and press the
<ENTER> button.

6

Press the scroll button several times
to select [Auto Power Off], and press
the <ENTER> button.

7

Press the scroll button or to select
[Enable], and press the <ENTER>
button.

8

Press the <ON LINE> button to exit the
menu mode.

To enable the auto power off mode while
connecting to the network perform the following
procedure.

1

2

3

Press the scroll button
operator panel.

or

on the

Press the scroll button several times
to select [Admin Setup], and press the
<ENTER> button.

Enter the administrator password, using
the numeric (0-9) keys.
The factory default password is “999999”. Press
the <ENTER> button whenever inputting one
character.

4

Press the <ENTER> button.
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Settings for Turning Power Off Automatically (Auto Power Off)

Setting the Time that Elapses Before
Entering the Auto Power Off Mode

Memo

●● The auto power off time can be selected from the
followings:
--[1 hour]

Note

--[2 hours]

●● When a printer is in the power saving mode, press the
<POWER SAVE> button to restore from the mode.

--[3 hours]
--[4 hours]

●● Check if the message “Ready To Print” appears. If the
message is not displayed, press the <ON LINE> button.

--[8 hours]
--[12 hours]

Press the <Fn> key on the operator
panel.

2

Enter “202” using the numeric keypad
and then press the <ENTER> button.

3

Press the scroll button or to specify
the time and then press the <ENTER>
button.

4

Press the <ON LINE> button.

--[18 hours]
--[24 hours]
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1

2

Setting the Buzzer

●●
Setting the Buzzer
You can set the buzzer volume when a paper jam occurs.

2
2. Printing Basic Operation

1

Press the scroll button
operator panel.

2

Press the scroll button several times
to select [Admin Setup], and press the
<ENTER> button.

3

or

on the

Enter the administrator password using
the numeric (0-9) keys, and press the
<ENTER> button.
The factory default password is “999999”. Press
the <ENTER> button whenever inputting one
character.

4

Press the <ENTER> button.

5

Press the scroll button several times
to select [Buzzer Setup], and press the
<ENTER> button.

6

Press the scroll button several times
to select [Paper Jam Error Buzzer
Volume], and press the <ENTER>
button.

7

Press the scroll button several times
to select a volume level, and press the
<ENTER> button.

8

Press the <ON LINE> button to exit the
menu mode.
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3. Troubleshooting
This chapter provides solutions to the problems you may encounter while operating your printer.
Memo

●● Meanings of symbols in error messages:
-- “%COLOR%” indicates Cyan (C), Magenta (M), Yellow (Y) or White (W).
-- “%TRAY%” indicates tray 1 or the MP tray.
-- “%COVER%” indicates a front cover or output tray.
-- “%CODE%” indicates a code number displayed in 1 to 3 digits. A code number changes according to an error.
-- “%MEDIA_SIZE%” indicates paper size.
●● When the message “Please see Help for details” appears on the display screen, you can check an error code and remedy
error by pressing the <HELP> button on the operator panel.

●●
When an Error Message Appears on the Display
Screen (When the ATTENTION Indicator Lights
Up/Blinks)
When a printer problem occurs, an error message appears on the display screen and the
<ATTENTION> indicator on the operator panel lights up or blinks. Check the error message and deal
with the problem according to the relevant procedure.
When “Please see Help for details” appears on the display screen, press the <HELP> button to display a
remedy.
Message on the display screen

<HELP> button

××××

Please see HELP for details.

When “Please see Help for details” appears on the display screen,
<ATTENTION> indicator

press the <HELP> button to display a remedy. Help is not available
when this message is not displayed.

Display Screen when the <HELP> button is pressed
Error Code

Scroll display upward

Remedy

Scroll display downward

××××
××××
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-- “%MEDIA_TYPE%” indicates a paper type.

3

When Paper Jams Occurs/When an Error Message does not Disappear Even After Jammed Paper is Removed

●●
When Paper Jams Occurs/When an Error
Message does not Disappear Even After Jammed
Paper is Removed
When paper is jammed inside a printer or when an error message does not disappear even after
jammed paper is removed, an error message appears on the display screen.

3

Press the <HELP> button to display a remedy. Remove jammed paper according to the remedy
displayed or the relevant procedure described in the following list.
<HELP> button

3. Troubleshooting

Message on the display screen (first line)
Message on the display screen (second line)

××××
××××

Please see HELP for details.

Press the <HELP> button to display a remedy.
<ATTENTION> indicator

Display Screen when the <HELP> button is pressed
Error Code

Scroll display upward

××××

Scroll display downward

Status
Paper jams

Paper jams

Message on the Display Screen
1st Line
2nd Line
3rd Line
1st Line
2nd Line
3rd Line
1st Line
2nd Line
3rd Line
1st Line
2nd Line
3rd Line
1st Line
2nd Line
3rd Line
1st Line
2nd Line
3rd Line

Open Cassette
Paper Jam
%TRAY%
Open Cover
Paper Jam
Front Cover
Open Cover
Paper Jam
Front Cover
Open Cover
Paper Jam
Output Tray
Open Cover
Paper Jam
Output Tray
Check Paper
Paper Multi Feed
%TRAY%

- 66 -

Message displayed
after the <HELP>
button is pressed
Error Code

Reference
Page

391, 392, 393, 394

page 72

380

page 67

390

page 71

381

page 68

382, 383

page 69

401

page 67

When Paper Jams Occurs/When an Error Message does not Disappear Even After Jammed Paper is Removed

Status
A message does not
disappear.

Message on the Display Screen
Open Cassette
Paper Remain
%TRAY%
Open Cover
Paper Remain
Front Cover
Open Cover
Paper Remain
Output Tray
Open Cover
Paper Remain
Output Tray

3

Error Code 380, 401, 637

Reference
Page

631, 632, 633, 634

page 72

637

page 71

638

page 68

639, 640

page 69

Close the front cover (2).

A paper jam has occurred around the front
cover.

1

Insert your finger into the recess on
the right side of the printer and pull the
front cover open lever (1) to open the
front cover (2) forward.
2

Task is complete.

1

2

2

Remove the jammed paper gently in the
direction of the arrow if you can see an
edge of jammed paper.
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1st Line
2nd Line
3rd Line
1st Line
2nd Line
3rd Line
1st Line
2nd Line
3rd Line
1st Line
2nd Line
3rd Line

Message displayed
after the <HELP>
button is pressed
Error Code

When Paper Jams Occurs/When an Error Message does not Disappear Even After Jammed Paper is Removed

Error Code 381, 638

4

Cover the removed image drums with
paper so that the image drums are not
exposed to light.

5

Pull out the jammed paper gently to the
rear of the printer (the direction of the
arrow) if an edge of jammed paper can
be seen.

A paper jam has occurred under an image drum.

1

Insert your finger into the recess on
the right side of the printer and pull the
front cover open lever (1) to open the
front cover (2) forward.

3
3. Troubleshooting

1

2

2

Press the output tray open button (3)
and open the output tray (4).

CAUTION

Possible to get
burned.

●● The fuser unit is extremely hot. Do not touch
it.
3
4

Pull out the jammed paper gently while
lifting the release levers (5) on the fuser
unit if an edge of jammed paper cannot
be seen.
If an edge of jammed paper still remains inside
the unit, pull out the jammed paper gently to the
rear of the printer.

3

Remove all four image drums and place
them on a flat surface.

5
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When Paper Jams Occurs/When an Error Message does not Disappear Even After Jammed Paper is Removed

6

Return all four image drums into the
printer carefully.

Error Code 382, 383, 639, 640
A paper jam has occurred around the fuser unit.

1

Insert your finger into the recess on
the right side of the printer and pull the
front cover open lever (1) to open the
front cover (2) forward.

3

7

Close the output tray (4) by pushing the
both sides of the cover firmly.
4

2

2

Press the output tray open button (3)
and open the output tray (4).

CAUTION

Possible to get
burned.

●● Since the fuser unit gets hot, carry out the
operation carefully, and when lifting it up
you must hold it by the handle. Do not try to
hold it whilst it is hot. Wait until it has cooled
down and then carry out the operation.

8

3

Close the front cover (2).

4

Note

●● The front cover cannot be closed if the output tray is
not closed securely.

2

Task is complete.
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1

When Paper Jams Occurs/When an Error Message does not Disappear Even After Jammed Paper is Removed

3

Remove all four image drums and place
them on a flat surface.

6

Lift the left lock lever (5) of the fuser
unit forward.

5

3
3. Troubleshooting

7
4

Cover the removed image drums with
paper so that the image drums are not
exposed to light.

6

8
5

Hold the fuser unit handle (6) and lift
the fuser unit out of the printer.

Remove the jammed paper remaining
inside of the unit.

Lift the release levers (7) on the fuser
unit, and pull out the jammed paper
forward gently.
7
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When Paper Jams Occurs/When an Error Message does not Disappear Even After Jammed Paper is Removed

9

Hold the fuser unit handle (6) and place
the fuser unit into the printer.

12 Close the output tray (4) by pushing the
both sides of the cover firmly.

6

4

3

unit backward.

13 Close the front cover (2).
Note

●● Cannot close the front cover securely if the output
tray is not closed.
5

11 Return all four image drums into the

2

printer carefully.

Task is complete.

Error Code 390, 637
A paper jam has occurred while feeding paper
from a paper tray.

1

If there is any paper on the MP tray, lift
the paper set cover (1) and take it out.

1
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10 Push the left lock lever (5) of the fuser

When Paper Jams Occurs/When an Error Message does not Disappear Even After Jammed Paper is Removed

2

Insert your finger into the recess on
the right side of the printer and pull the
front cover open lever (2) to open the
front cover (3) forward.

5

If loading paper on MP tray, lift the
paper set cover (1) and set the paper
with the print side face up.

2

1

3
3. Troubleshooting

3

3

Remove the jammed paper gently by
pulling the edge of paper.

6

Lower the paper set cover (1).

1

Task is complete.
Remove the paper from the back gently
if the edge of paper cannot be seen.

Error Code 391, 392, 393, 394, 631,
632, 633, 634
A paper jam has occurred while feeding paper
from a paper tray.
Note

●● If paper jams occur frequently, clean the paper feed
rollers. For details, refer to “Cleaning Paper Feed Rollers”
P.106.

This procedure uses Tray 1 as an example.

4

Close the front cover (3).

3
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1

Gently pull out from the printer the tray
(1) for which an error is indicated.

4

Insert your finger into the recess on
the right side of the printer and pull the
front cover open lever (2) to open the
front cover (3) forward.

2

3. Troubleshooting

3
1

2

5

Close the front cover (3).

Remove the jammed paper.

3

Task is complete.

3

Memo

Return the tray (1) to the printer.

●● Open and close the front cover after removing the
jammed paper otherwise the error indication do not
go out.

1
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3

When the Message for Replacement of Consumables or Maintenance Unit Appears

●●
When the Message for Replacement of
Consumables or Maintenance Unit Appears
When the time to replace consumables or maintenance unit is close and replacement must be done,
the message “…Low”, “…Near Life”, “…Empty”, “…Life”, “Install…”, “Replace…”, “Change…”
appears on the display screen and the <ATTENTION> indicator on the operator panel lights up or blinks.
Check the message and replace consumables and maintenance unit.

3

<HELP> button
Message on the display screen (first line)

××××

Message on the display screen (second line)

××××
××××

3. Troubleshooting

Message on the display screen (third line)

××××
Please see HELP for details.

Message on the display screen (fourth line)

Press the <HELP> button to display a remedy.

<ATTENTION> indicator

Display Screen when the <HELP> button is pressed
Error Code

Scroll display upwards

××××
××××

Scroll display downwards
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When the Message for Replacement of Consumables or Maintenance Unit Appears
Memo

●● “xxx” described on the list below changes according to the printer status.

Status

Message on the Display Screen

Toner Cartridge 1st Line
2nd Line

-

1st Line
2nd Line
1st Line
2nd Line
1st Line
2nd Line

xxx
%COLOR% Toner Empty
Install Toner
%COLOR%
xxx
%COLOR% Image Drum Near
Life

1st Line
2nd Line
1st Line
2nd Line

xxx
%COLOR% Image Drum Life
xxx
%COLOR% Image Drum Life,
%nnn% Pages Left
Install New Image Drum
Image Drum Life
%COLOR%

1st Line
2nd Line
3rd Line

410, 411, 413
412
-

-

page 96
page 94
Prepare new image drums,
and replace the old image
drums with new ones after a
message for replacement of
consumables or maintenance
unit appears.
page 98
page 98
The number of pages you can
print is displayed in “nnn”.

350, 351, 352, 353

page 98
If a toner remains, you can
continue to print by opening
or closing the front cover.
However, replace the image
drum soon. Otherwise, it may
cause a decrease in a printing
quality.
page 98

Install New Image Drum
Image Drum Life
%COLOR%
Install New Image Drum
Image Drum Life
%COLOR%
To Exceed the Life, Press
Online Button

560, 561, 562, 563

1st Line
2nd Line

Install New Image Drum
Printing disabled due to low
threshold of Image Drum life.
%COLOR%

680, 681, 682, 683
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Prepare a new toner
cartridge, and replace the
old toner cartridge with new
one after a message for
replacement of consumables
or maintenance unit appears.
page 94

-

1st Line
2nd Line
3rd Line
1st Line
2nd Line
3rd Line
4th Line

3rd Line

Reference Page or
Remedy

564, 565, 566, 567

page 98
Pressing the <ONLINE>
button can resume printing
without guarantee of print
results. Please replace it as
soon as possible.
page 98

3
3. Troubleshooting

Image Drums

xxx
%COLOR% Toner Low

Message displayed
after the <HELP>
button is pressed
Error Code

When the Message for Replacement of Consumables or Maintenance Unit Appears

Status
Fuser Unit

3
3. Troubleshooting

Belt Unit

Message on the Display Screen

Message displayed
after the <HELP>
button is pressed
Error Code

1st Line
2nd Line

xxx
Fuser Unit Near Life

-

1st Line
2nd Line
1st Line
2nd Line

xxx
Change Fuser Unit
Install New Fuser Unit
Fuser Unit Life

-

1st Line
2nd Line

xxx
Belt Unit Near Life

-

1st Line
2nd Line
1st Line
2nd Line

xxx
Change Belt Unit
Install New Belt Unit
Belt Unit Life

-

354

355
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Reference Page or
Remedy
Prepare a fuser unit, and
replace the old fuser unit with
new one after a message for
replacement of consumables
or maintenance unit appears.
page 104
page 104
You can continue to print by
opening or closing the front
cover for a while. However
replace the fuser unit soon.
Otherwise, it may cause a
printer error or paper jam.
Prepare a belt unit, and
replace the old belt unit with
new one after a message for
replacement of consumables
or maintenance unit appears.
page 101
page 101
You can continue to print by
opening or closing the front
cover for a while. However
replace the belt unit soon.
Otherwise, it may cause a
printer error.

When the Message for Paper Replacement or Paper Size Error Appears

●●
When the Message for Paper Replacement or
Paper Size Error Appears
When the media type or media size loaded in a tray does not match the settings specified in the printer
driver, the message “Change Paper...” or “Check Paper...” appears on the display screen and the
<ATTENTION> indicator blinks.
Check the message and deal with the problem. Check the paper size and the settings, refer to “How to
Print from the Tray” P.48 or “How to Print from the MP Tray” P.49.

3

<HELP> button
Message on the display screen (first line)

××××
××××

3. Troubleshooting

Message on the display screen (second line)

××××

Message on the display screen (third line)

××××
Please see HELP for details.

Message on the display screen (fourth line)

Press the <HELP> button to display a remedy.

<ATTENTION> indicator

Display Screen when the <HELP> button is pressed
Error Code

Scroll display upward

××××
××××

Scroll display downward

Status

Change Paper

Paper Size does not match print data.

Paper Size Error

Message on the Display Screen

1st Line
2nd Line
3rd Line
4th Line
1st Line
2nd Line
3rd Line
4th Line
1st Line
2nd Line
3rd Line
4th Line
1st Line
2nd Line
3rd Line
4th Line
1st Line
2nd Line
3rd Line
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Change Paper in %TRAY%
%MEDIA_SIZE%
%MEDIA_TYPE%
Press ONLINE Button
Change Paper in MPTray
%MEDIA_SIZE%
%MEDIA_TYPE%
Press ONLINE Button
Change Paper in %TRAY%
%MEDIA_SIZE%
%MEDIA_TYPE%
Press ONLINE Button
Change Paper in MPTray
%MEDIA_SIZE%
%MEDIA_TYPE%
Press ONLINE Button
Check Paper
Paper Size Error
%TRAY%

Message
displayed after
the <HELP>
button is
pressed
Error Code
661, 662, 663, 664

660

461, 462, 463, 464

460

400

Other Error Messages

●●
Other Error Messages
This section explains the causes and remedies for an error message and the function of the
<ATTENTION> indicator. An error message appears on the display screen of the operator panel.
To display an error code, press the <HELP> button on the operator panel.

Error Messages

3

Error
code

Message

<ATTENTION>
indicator

3. Troubleshooting

420

Press ONLINE button for Restoration
Memory Overflow

Blinks

310
311

%COVER% Open.

Blinks

Please see HELP for details
Check Fuser Unit

Blinks

320
348

610
611
612
613

Please see HELP for details
Check Data
Message Data Write Error<%CODE%>
Toner Not Installed
%COLOR%

Lights up
Blinks

Please see HELP for details

544
545
546
547

Check Toner Cartridge
Improper Lock Lever Position
%COLOR%

540
541
542
543

Toner Sensor Error
%COLOR%

430
440

Install Paper Cassette
%TRAY%

Blinks

Please see HELP for details

Blinks

Please see HELP for details

Blinks

Please see HELP for details

356

Install New Belt Unit
Belt Unit Life
Please see HELP for details
File System is Full

Blinks

Lights up
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Cause/Remedy
The memory overflowed.
Reduce the data amount. If that does not
work, reduce the size of the print data.
The cover is open.
Close the cover.
310 : Output tray
311 : Front cover
The fuser unit is not correctly installed.
Install the fuser unit correctly in a printer.

Writing of message data to be uploaded to a
printer has been failed.
The toner cartridge of the indicated color
is not installed correctly. Install the toner
cartridge correctly.
610 : Yellow (Y)
611 : Magenta (M)
612 : Cyan (C)
613 : White (W)
The toner cartridge of the indicated color is
not locked properly.
Turn the blue lever on the right side of the
cartridge backwards until it stops.
544 : Yellow (Y)
545 : Magenta (M)
546 : Cyan (C)
547 : White (W)
Something is wrong with the toner sensor of
the indicated color or the image drum is not
installed correctly.
Install the toner cartridge or image drum of
the indicated color correctly.
540 : Yellow (Y)
541 : Magenta (M)
542 : Cyan (C)
543 : White (W)
A paper cassette is not in the indicated tray.
Insert the paper cassette into the indicated
tray.
If the cassette is already inserted in the
printer, pull out the cassette and set it again
to correctly locate it.
430, 440 : Tray1
The belt unit is at the end of its life.
Replace it with a new belt unit.

The file system is full.

Other Error Messages

Error
code

Message
File System is Write Protected

330

Check Belt Unit

491

Please see HELP for details
Erased Data Full
Install Paper
%TRAY%
%MEDIA_SIZE%

694
695
696
697

340
341
342
343

Lights up
Blinks

The file system to which you tried to write is
write-protected.
The belt unit is not properly installed.
Reinstall it properly.

Lights up
Blinks

Secret file to be erased are full.
The indicated tray is empty.
Load the indicated size paper.
491 : Tray1

Lights up
Goes off
Blinks

Erasing a secret file.
A postscript error has occurred.
Paper in the MP tray is empty.
Load the indicated size paper.

Blinks

Please see HELP for details

Check Image Drum
%COLOR%

Cause/Remedy

Blinks

Please see HELP for details

Wait a Moment
Rebooting <n>
%COLOR% Toner Sensor Error

Lights up

%COLOR% Toner Not Installed

Lights up

%TRAY% Empty

Lights up

Unsupported USB Device Detected

Goes off

Lights up

The image drum of the indicated color is not
installed correctly. Install the image drum
correctly.
694 : Yellow (Y)
695 : Magenta (M)
696 : Cyan (C)
697 : White (W)
The image drum of the indicated color is not
installed correctly. Install the image drum
correctly.
340 : Yellow (Y)
341 : Magenta (M)
342 : Cyan (C)
343 : White (W)
The printer is restarting.
Please wait.
Something is wrong with the toner sensor of
the indicated color or the image drum is not
installed correctly.
Install the toner cartridge or image drum of
the indicated color correctly.
The toner cartridge of the indicated color
is not installed correctly. Install the toner
cartridge correctly.
The indicated tray is empty.
Load the paper.
A USB device unsupported by a printer is
connected. Remove the device.

Please detach it
Install Paper
MPTray
%MEDIA_SIZE%
Press ONLINE Button
%COLOR% Waste Toner Full.Replace Toner.

Goes off

Load the paper of the size indicated in the
MP tray, and then press the <ON LINE>
button.

Lights up

Collate Fail:Too Many Pages

Goes off

Press ONLINE Button
File System Operation failed<nnn>

Lights up

Waste toner is full. Replace with a new toner
cartridge of the indicated color.
A collate print error has occurred.
Reduce the data amount. If that does not
work, reduce the size of the print data.
An error of file system for a printer has
occurred.

Press ONLINE Button
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490

Please see HELP for details
File Erasing
Error Postscript
Install Paper
MPTray
%MEDIA_SIZE%
Press ONLINE Button
Please see HELP for details
Image Drum Not Installed
%COLOR%

<ATTENTION>
indicator

Other Error Messages

Error
code

Message
Power Off and Wait for a while
126:Condensing Error
USB Hub Unsupported

nnn*

3

nnn*

Please detach it
Service Call
nnn: Error

<ATTENTION>
indicator
Blinks

Goes off

Blinks

3. Troubleshooting

Power Off/On
nnn:Error

Blinks

PDL Error Occurred

Varies

Expired saved files have been deleted
Press ONLINE Button
Decode error occurred

Lights up

Varies

Press ONLINE Button

Can not read the file

Varies

Press ONLINE Button
Color toner empty. Job cancelled
Press ONLINE Button
E-mail receiving has been cancelled

Varies

Lights up

Press ONLINE Button

Invalid Data

Varies

Press ONLINE Button
Job Type restricted
Job rejected
Press ONLINE Button
Please change SD Memory Card

415
417

Replace Toner
%COLOR% Waste Toner Full

Varies

Lights up

Blinks

Please see HELP for details
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Cause/Remedy
A condensation has occurred inside a printer.
Turn the printer off and turn on again after
a while.
A USB hub unsupported by a printer is
connected. Remove the hub.
A fatal error has occurred inside the device.
Write down the error code and contact your
dealer.
A fatal error has occurred in a printer.
Turn the power off/on. Contact your dealer if
the same error occurs again.
Indicating that it has been occured an
internal processing error into the PDL
emulation.
It's a clearable warning. User should press
ENTER button for clearing the warning.
Indicates that an applicable job has been
automatically deleted as the retention period
for Private Job Print has expired.
Indicates that an error has occurred during
analysis of image data input from an
external source.
This appears when an error has occurred
during analysis of TIFF or JPEG data in
USBMemoryPrint, DirectPrint, E-mailPrint
mode.
Indicates that the USB memory is
disconnected while PrintFromUSBMemory
is running. Reading of the image file is
cancelled.
Notifies the user that the color toner is
empty and that the received color data job
is cancelled.
Indicates that Email receiving has been
canceled.
It has the following possibilities.
- The format of email that has received is
illegal or not supported.
- The attached file is illegal or not
supported.
- The attached file that has received is too
large, for example, file size exceeds 8MB.
- Network connection has disconnected.
Invalid data was received. Press the On-line
switch and eliminate the warning. Displayed
when unsupported PDL command is received or
a spool command is received without SD Card.
A job of a JobLimitation setting violation is
received, and when discarding the job, it's
indicated.
Indicates that machine requests a user to
exchange old SD card device for new one
because the SD card device is life.
Indicates that a waste toner box represented
by %COLOR% has become full and needs to
be replaced.
Error 415 : Magenta
Error 417 : White

Other Error Messages

Error
code
480

519

Message
Remove Paper
Output Tray
Please see HELP for details
Press ONLINE Button for Restoration
Receiving Data Timeout

709

Caution, unknown Consumable detected
Go to User Manual “Trouble Shooting” to
restore operation

Cause/Remedy

Blinks

The printed paper is overfilled on the paper
stacker of the printer unit.
Error 480 : Output Tray

Blinks

When receiving data by Port9100, LPR, FTP,
IPP, WSD, or Email, a timeout occurred in
stream.

Varies

IPv4 address is conflicted.

Varies

Indicates that DHCP server is not found out.

Varies

This appears when the NIC initialization is
occurred, as the setting was changed.
This appears during the NIC configuration
data is storing into the flash memory, as the
setting was changed.
You can use any consumables in your
product, but you must accept the risks of
using non-genuine consumables. If the use
of non-genuine consumables causes damage
to the product or results in your product
not functioning to its full specification, then
such damage or effect on the product is not
covered by warranty. To accept these risks
and to restore function;
1. Turn off your product
2. Press and hold the <CANCEL> button
and turn your product on
3. After start up, release the <CANCEL>
button

Blinks

Blinks

Note

This operation will be recorded for future
reference.
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3. Troubleshooting

Please see HELP for details
IPv4 Address is conflicted
Change IPv4 Address
Getting target IP failed. Please check DHCP
settings.
Wait a Moment
Network Initializing
Wait a Moment
Network Configuration writing

<ATTENTION>
indicator

When You Cannot Print from the MP Tray

●●
When You Cannot Print from the MP Tray
If you print from the MP tray without moving down the paper set cover, the message
“Install Paper MPTray” appears on the display screen.
Check the message and deal with the problem. Refer to ”How to Print from the MP Tray” P.49.

3

Paper set cover

3. Troubleshooting
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Other Issues

●●
Other Issues
This section explains the issues you may encounter while operating your printer and how to solve them.

Unable to Print from a Computer
Memo

●● If the following information does not solve the issue, contact your dealer.
●● For issues caused by an application, contact the manufacturer of the application.

3

General Causes

Cause
The printer is turned off.
An Ethernet or USB cable is unplugged.
Something is wrong with a cable.
The printer is off line.
An error message is displayed on the
display screen of the operator panel.
The interface setting is disabled.
Something is wrong with the print
function.

Remedy

Reference

Turn on the printer.
Check that the cable is plugged into the printer and
computer properly.
Replace it with a new cable.
Press the <ON LINE> button.

page 21
-

“Error Messages” or press the <HELP> button on the
operator panel.
Check the setting of the interface being used from the
operator panel.
Check if you can print the contents of the settings.

page 78

-

Advanced
page 29

 For Windows
Cause
The printer is not set as the default
printer.
The output port for the printer driver is
incorrect.
A print job from another interface is in
progress.
“Invalid Data” is displayed on the
display screen and printing cannot be
done.

Remedy

Reference

Set the printer as the default printer.

-

Select the output port to which the Ethernet or USB
cable is connected.
Wait until the print job is done.

-

Press the scroll button or and select [Menus] >
[System Adjust] > [Timeout InJob], and then select
a longer time. The default setting is 40 seconds.
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3. Troubleshooting

 Common to Windows and OS X

Other Issues

Network Connection Problems
 Common to Windows and OS X
Cause

3

Using a crossover cable.
The printer is turned on before a cable
was connected.
The hub and the printer are incompatible
or have some problem.

Remedy
Use a straight cable.
Connect cables before turning on the printer.

Reference
page 31

3. Troubleshooting

Press the scroll button or and select [Admin Setup]
(Enter the administrator password.) > [Network Setup] >
[HUB Link Setting], and then select [10Base-T Half].

-

Remedy

Reference

 For Windows
Cause
IP address is incorrect.

●● Check that the same IP address is set for the printer
and the printer's port setting on the computer.
●● If using LPR Utility, check the IP address setting in
LPR Utility.

-

USB Connection Problems
 Common to Windows and OS X
Cause
Unsupported USB cable is being used.
A USB hub is being used.
Printer driver is not installed correctly.

Remedy
Use a USB 2.0 cable.
Connect the printer directly to the computer.
Reinstall printer driver.

Reference
page 41
page 41,
page 42

 For Windows
Cause
The printer is off line.

Remedy
Right-click the Pro8432WT PS icon, and then select
[See what's printing]. In the dialog box, select the
[Printer] menu and then remove the check from
[Use Printer Offline].
Connect the printer directly to the computer.

A switch, buffer, extension cable or USB
hub is being used.
A driver for a different printer that uses a Delete the other printer driver from the computer.
USB connection has been installed.
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Reference
-

page 41
-

Other Issues

Unable to Install a Printer Driver Successfully
Memo

●● If the following information does not solve the issue, contact your dealer.
●● For issues caused by an application, contact the manufacturer of the application.

USB Connection Problems
 For Windows
Cause

The printer driver is not installed correctly.
Reinstall the printer driver correctly.
Follow the procedure below to install the second and
subsequent printer drivers:
1. Insert the “Software DVD-ROM” into a computer.
2. When [AutoPlay] is displayed, click [Run Setup.exe].

Reference
page 41
-

Memo

●● If the [User Account Control] dialog box is displayed,
click [Yes].

The “Unable to install printer driver”
error message is displayed.

3. Select a language from the drop-down list.
4. Read the license agreement, and then click [Accept].
5. R
 ead Environmental advice for Users and click
[Next].
6. S
 elect [Network (Wired/Wireless)] or [USB]
corresponding to your connection environment, and
then click [Next].
If the [Windows Security Alert] dialog box is
displayed, click [Allow access].
7. S
 elect the model name of this machine, and then
click [Next].
8. Click [Custom Install].
9. Click [Separate Install].
10. C
 lick a driver to install.
Installation starts.
Use Plug-and-Play. Follow the procedure below.
1. E
 nsure that the printer and computer is turned off.
2. C
 onnect a USB cable.
3. T
 urn on the printer.
4. T
 urn on the computer.
5. W
 hen the Found New Hardware Wizard is displayed,
follow the on-screen instructions to complete the
setup.
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3

-

3. Troubleshooting

An icon of the printer is not created on
the [Devices and Printers] folder.
Only the first printer driver is installed
even if multiple printer drivers are
selected to install.

Remedy

Other Issues

OS-Specific Constraints
Constraints with Windows
Item

3

Symptom

Printer drivers

[Help] is not displayed.
The [User Account Control]
dialog appears.

PS Gamma
Adjuster

The [User Account Control]
dialog appears.

3. Troubleshooting

The [Program Capability
Assistant] dialog appears.

Cause/Remedy
The [Help] function is not supported on PS printer drivers.
When you launch an installer or utility, the [User Account
Control] dialog may appear. Click [Yes] or [Continue] to
run the installer or utility as an administrator. If you click
[No], the installer or utility does not start.
When you launch an installer or utility, the [User Account
Control] dialog may appear. Click [Yes] or [Continue] to
run the installer or utility as an administrator. If you click
[No], the installer or utility does not start.
If the [Program Capability Assistant] dialog appears
after an installation (including if you stop an installation
before it is completed), make sure to click [This program
installed correctly].

- 86 -

Other Issues

Image Quality Issues
Memo

●● If the following information does not solve your issues, contact your dealer.

Symptom
Vertical lines appear.

Paper feed direction

Remedy

The toner is low.
The image drum is damaged.
Foreign materials may be present
on the image drum.
The light-shielding film of the
image drum is dirty.
The image drum is not installed
properly.
The LED heads are dirty.
The toner is low.
The paper is unsuitable.

Replace the toner cartridge.
Replace the image drum.
Replace the image drum.
Wipe the film with a soft tissue
paper.
Install the image drum properly.
Wipe the LED heads with soft
tissue paper.
Replace the toner cartridge.
Use supported paper.

Reference
page 94
page 98
page 98
page 98
page 108
page 94
page 45

Paper feed direction

Printed images are light. The toner save is enabled.
The toner cartridge is not installed
properly.
The toner is low.
The paper is moist.

The paper is unsuitable.
The paper is unsuitable.
The settings of media type and
weight are incorrect.

The paper is recycled.
The media weight setting is
unsuitable.

Printed images are
partially faded. Spots
and lines appear.

The paper is too moist or dry.

[Paper Color Setting] is
improperly configured.

[Trans. Color Setting] is
improperly configured.
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Change the toner save settings.
Install the toner cartridge properly.

page 94

Replace the toner cartridge.
Use paper stored in proper
temperature and humidity
conditions.
Use supported paper.
Press the scroll button or
and select [Menus] > [Tray
Configuration] > the paper tray
configuration you are using, and
then select the proper values
for [Media Type] and [Media
Weight]. Or, select a larger value
for [Media Weight].
Press the scroll button or
and select [Menus] > [Tray
Configuration] > the paper tray
you are using, and then select a
larger value for [Media Weight].
Use paper stored in proper
temperature and humidity
conditions.
Press the scroll button or ,
select [Menus] > [Print Adjust],
and then change the value of
[Paper Color Setting].
Press the scroll button or ,
select [Menus] > [Print Adjust],
and then change the value of
[Trans. Color Setting].

page 94
page 45

page 45
page 45

page 45

page 45

-

-

3
3. Troubleshooting

Printed images are
fading vertically.

Point to check

Other Issues

Symptom
Horizontal lines
and spots appear
periodically.

Paper feed direction

3
3. Troubleshooting

White area of paper is
lightly stained.

Point to check

Remedy

If the interval of lines or spots
is about 94 mm (4 inches), the
image drum (the green tube) is
damaged or dirty.
If the interval of lines or spots is
about 40 mm (2 inches), foreign
materials may be present on the
image drum.
If the interval of lines or spots is
about 143 mm, there is damage to
the fuser unit.
The image drum has been exposed
to light.

The paper feed path is dirty.
The paper contains static
electricity.
The paper is too thick.
The toner is low.

Periphery of letters is
smudged.

The LED heads are dirty.

Change the fuser unit.

Place the image drum back into
the printer and leave it for a few
hours. If that does not solve the
problem, replace the image drum.
Print a few test copies.
Use paper stored in proper
temperature and humidity
conditions.
Use thinner paper.
Replace the toner cartridge.

Wipe the LED heads with soft
tissue paper.
Use recommended paper.
Replace it with new paper.

The paper is unsuitable.
The paper is moist.

The entire paper area
The toner may be sticking to the
is lightly stained when
whole area of the envelope or
printing on envelopes or coated paper.
coated paper.

Toner comes off when it
is rubbed.

Lightly wipe the image drum with
soft tissue paper.
Replace the image drum if it is
damaged.
Open and close the output tray,
and print again.

The settings of media type and
weight are incorrect.

The paper is recycled.
The media weight setting is
unsuitable.
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Reference
page 98

-

page 104

page 98

page 45

page 94

page 108
page 45

This is not a malfunction of the
printer.
Coated paper is not recommended.

-

Press the scroll button or
and select [Menus] > [Tray
Configuration] > the paper
tray configuration you are using,
and then select the proper
values for [Media Type] and
[Media Weight]. Or, select a
heavier weight in [Media Weight].
Press the scroll button or
and select [Menus] > [Tray
Configuration] > the paper tray
configuration you are using, and
then select a heavier weight for
[Media Weight].

page 45

page 45

Other Issues

Symptom

Point to check
The settings of media type and
weight are incorrect.

Color of the printed
image is not what you
expect.

The toner is low.
The color adjustment has been
modified.
The color balance is out of
adjustment.
Color registration is out of
alignment.

Reference

Press the scroll button or
and select [Menus] > [Tray
Configuration] > the paper
tray configuration you are using,
and then select the proper
values for [Media Type] and
[Media Weight]. Or, select a
heavier weight in [Media Weight].
Replace the toner cartridge.
Do color matching from the printer
driver.
Press the scroll button or and
select [Calibration], and then
[Adjust Density].
Open and close the output tray.
Or, press the scroll button or
and select [Calibration], and then
[Adjust Registration].
Press the scroll button or and
select [Admin Setup] > [Color
Setup] > [CMY100% Density],
and then select [Enable].

page 45

page 94
Advanced
Advanced

Advanced

Solid printing of CMY
100% is too light.

[CMY100% Density] is set to
[Disable].

Dots appear.

The paper is unsuitable.
When the interval of the dots
is about 94 mm (4 inches), the
image drum (the green tube) is
damaged or dirty.

Use supported paper.
Lightly wipe the image drum with a
soft tissue paper.
Replace the image drum when it is
damaged.

page 45
page 98

Smears is printed.

The paper is moist.
The paper is unsuitable.

Replace it with new paper.
Use supported paper.

page 45
page 45

The background of a
printed page is dark or
dirty.

The printer may be malfunctioning. Contact your dealer.

Nothing is printed.

Two or more sheets of paper are
Fan the paper well and load it
fed simultaneously.
again.
The printer may be malfunctioning. Contact your dealer.

page 48,
page 49
-

The paper is moist.
The paper is unsuitable.

page 45
page 45

?

Patches appear.

Replace it with new paper.
Use supported paper.
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Back cover

3
3. Troubleshooting

Glossiness is not
uniform.

Remedy

Other Issues

Feeding Issues
Memo

●● If the following information does not solve the issue, contact your dealer.

Symptom

3

●● The paper often
jams.
●● Multiple sheets
are fed at once.
●● The paper is fed
at an angle.

Point to check
The printer is tilted.
The paper is too light or too heavy.
The paper is moist or has a static
charge.

3. Troubleshooting

The paper is wrinkled, folded or
curled.
Something is already printed on the
back side of the paper.
The edges of the paper are not kept
even.
There is only one sheet of paper in
the tray.
You have added more paper with
paper already loaded in the tray.

Remedy

Reference

Place the printer on a flat surface.
Use the appropriate paper for the
printer.
Use paper stored in proper
temperature and humidity
conditions.
Use appropriate paper for the printer.
Fix the curled paper.
With tray 1, you cannot use paper
that has been printed.
Load it on the MP tray for printing.
Fan the paper and even up the
edges.
Load several sheets of paper.

page 16
page 45

Remove the already loaded paper,
stack it onto the new paper, even up
the edges and load the paper with
the old paper on top.
The paper is loaded at an angle.
For tray 1, adjust the paper width
guide and stopper to the paper.
For the MP tray, adjust the paper
width guide to the paper.
Envelopes are not correctly loaded.
Load envelopes correctly.
Paper, envelopes or labels of weight Load the paper, envelopes or labels
between 177 and 220 g/m2 is loaded of weight between 177 and 220 g/m2
in tray 1.
on the MP tray, and use the face up
stacker.
Paper does not feed The setting of [Source] in the
Check the paper tray and select
into the printer.
printer driver is not correctly
the correct tray in [Source] in the
specified.
printer driver.
You have specified manual feeding
In the printer driver, clear the [Use
on the printer driver.
MP tray as manual feed] check
box on [Paper feed options].
The printer does
Open and close the output tray.
not start processing
even though you
have removed the
jammed paper.
The paper gets
The paper is moist or has a static
Use paper stored in proper
folded or wrinkled. charge.
temperature and humidity
conditions.
The paper is light.
Press the scroll button or and
then select [Menus] > [Tray
Configuration] > [%TRAY%
Config] > [Media Weight].
Then, specify a lighter weight.
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page 45

page 45
page 49

page 48,
page 49
page 48,
page 49
page 48,
page 49

page 48,
page 49

page 49
page 45,
page 49

-

Advanced

-

page 45

page 45

Other Issues

Symptom
The paper twists
around the rollers
in the fuser unit.

Point to check
The settings of media weight and
type are incorrect.

The paper is light.
There is an image or text on the
leading edge of the paper.

Reference

Press the scroll button or and
then select [Menus] > [Tray
Configuration] > [%TRAY%
Config] > [Media Type]/[Media
Weight]. Then, specify the
appropriate values.
Or, specify a heavier weight in
[Media Weight].
Use heavier paper.
Add a margin on the leading edge of
the paper.

page 45

Remedy

Reference

-

Machine Issues
Symptom

Point to check

You turned on the
The AC cord is unplugged.
printer, but nothing
displays on the
The power is out.
screen.
The printer does
not operate.

The printer does
not start printing.

The AC cord is not firmly plugged in.
The printer is turned off.
The printer turned off automatically
by the auto power off function.
Printer does not answer.

An error is displayed on the panel.
The Ethernet or USB cable is
unplugged.
Something is wrong with the
Ethernet or USB cable.
The printer does not support your
Ethernet or USB cable.

The display screen
is blank.

Print data is not
transmitted to the
printer.

Turn off the printer and then plug in
the AC cord firmly.
Check if the power is being supplied
to the electric outlet.
Plug in the AC cord firmly.
Turn on the printer.
Disable the auto power off function.
Hold down the power switch for more
than 5 seconds to turn off the printer
forcibly.
Check the error code and follow the
on-screen instructions.
Plug in the Ethernet or USB cable
firmly.
Use another Ethernet or USB cable.

●● Use a USB 2.0 compatible cable.
●● Use an Ethernet 10BASE-T/
100BASE-TX/1000BASE-TX
compatible cable.
Something may be wrong with the
Press the scroll button or and
printing function.
select [Print Information] >
[Configuration] and then print the
contents of the settings to check the
printing function.
The interface is disabled.
Press the scroll button or and
select [Admin Setup] > [Network
Setup] and enable the interface you
are using.
The printer driver of the printer is
Set the printer driver of the printer
not selected.
as the default printer.
The specified port of the printer
Specify the port the Ethernet or USB
driver is wrong.
cable is connected to.
The printer is in the deep sleep
Check if the <POWER SAVE>
mode.
button lights up and press the
<POWER SAVE> button to activate
the printer.
The Ethernet or USB cable is broken. Connect a new cable.
The time-out period set on the
Set a longer time-out period.
computer has passed.
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page 21
page 62
-

page 78
page 31,
page 41
-

page 29

-

page 22

-

3
3. Troubleshooting

Remedy

Other Issues

Symptom

Point to check

Remedy

There is an
abnormal sound.

3
3. Troubleshooting

The printer is tilted.
There is a piece of paper or foreign
object inside the printer.
The output tray is open.
There is a buzzing
The printer is printing on the heavy
sound.
or thin paper when the temperature
inside is high.
It takes a while to
The printer may be cleaning the
start printing.
image drum.
The printer is adjusting the
temperature of the fuser unit.
The printer is processing data from
another interface.
A print job has
As a result of processing print jobs
stopped in the
continuously for a long time, the
middle of the
inside the printer has become hot.
The printer is cooling off.
printing process.
As a result of processing print jobs
continuously for a long time, the
temperature in the printer inside
has become too high. The printer is
cooling off.
When the print processing is
overloaded by printing with the WSD
port, a computer may stop sending.
Memory is
A printer is short on memory
insufficient.
because print data is too large.
It takes a long time The processing speed of the
to finish printing.
computer may be slowing down the
print job.
You have selected [ProQ/High
Quality] on the [Job Options] tab
of the printer driver.

The printer driver
is not correctly
displayed on OS X.
Paper is curled.

Place the printer on a flat surface.
Check the inside of the printer and
remove any objects.
Close the output tray.
This is not a malfunction. You can
proceed with the operation.

Paper is wet on the Wet paper is used.
edge.
The LED indicator
The printer may be malfunctioning.
in the power switch
is blinking at high
speed per about
0.3 seconds.

-

Wait for a while.

-

Wait for a while.

-

Wait until the process finishes.

-

Wait for a while.
When the fuser unit becomes cooler,
printing restarts automatically.

-

Wait for a while.
When the printer becomes cooler,
printing restarts automatically.

-

Retry to send data on a computer. If
the error is not resolved, use other
network port.
Reduce print data with a printer
driver.
Use a computer with faster
processing speed.

-

Select [Fine / Detail (600x1200)]
or [Normal (600x600)] on the
[Job Options] tab of the printer
driver.
The print data is complex.
Make the data simpler.
Paper is narrow (less than 230 mm). Change the mode.
The printer driver may not be
Uninstall the printer driver and install
operating correctly.
it again.
Thin paper is used.

Reference

Set an appropriate paper weight or
select [High Humid Mode].
Select [Moisture Control].
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Unplug the AC cord immediately.

Advanced
-

-

Advanced
Advanced

Advanced
Advanced
-

4. Maintenance
This chapter explains how to replace consumables and maintenance units, clean the printer, and move
or transport the printer.

●●
Replacing Consumables and Maintenance Units
This section explains how to replace consumable items.

WARNING
Do not throw the toner or
toner cartridge into the fire.
Doing so may cause toner
splashes leading to burns.

Do not vacuum spilled toner
powder. If vacuuming, it may
cause ignition due to the
sparks from electric contacts.
Toners spillage on the floor
should be wiped off by wet
clothes.

CAUTION
There are high temperature
parts in the device. Do
not touch the periphery
of the label "Caution High
Temperature", which may
cause burns.
If the toner powder sticks to
your skin like your hands,
wash with soap.

When handling a paper
jam, or replacing the toner
cartridge, make sure not to
get your cloth and hands
dirty. When toner powder
stains on your cloth, wash
with cold water. If you wash
with hot water, the toner
may be soaked into the
cloth; it may be difficult to
clean.

Keep the toner cartridge out
of reach of young children. If
young children swallow toner
powder, follow the doctor's
direction immediately.
If the toner gets into the
eyes, flush with plenty of
water immediately. Follow
the doctor's direction if
necessary.
Do not disassemble the toner
cartridge. Toner powder may
fly upward, and you may
inhale the toner powder
or may get your cloth and
hands dirty.

If toner powder is inhaled,
gargle with large amounts of
water and move the person
to the open area for fresh air.
Follow the doctor's direction
if necessary.
If you swallow toner powder,
take large amounts of water
to weaken the toner. Follow
the doctor's direction if
necessary.
Keep a used toner cartridge
in a bag so that the toner
powder can not fly upward.

Note

●● Use only genuine OKI consumable items to ensure optimum quality.
●● Service for problems due to use of consumable items other than genuine OKI consumables will incur fees even in the warranty
period or the maintenance contract period.
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Do not keep the toner
cartridge in places close to
the fire. It may catch the
fire, which cause fire and
burns.

Replacing Consumables and Maintenance Units

Replacing Toner Cartridges

Procedure for Replacement
(for C (cyan) Toner Cartridge)

Note

●● Toner powder may spill if you remove a toner cartridge
before the toner runs out.

Life Span of Toner Cartridge
When the “%COLOR% Toner Low” message
(“%COLOR%” indicates C (cyan), M (magenta),
Y (yellow) or W (white)) appears on the display
screen, prepare a replacement toner cartridge.
You can keep printing several hundred pages
until the next message appears.

4

Memo

●● When replacing the W, M, Y toner cartridges, refer to
“Procedure for Replacement (for W (white), M (magenta),
Y (yellow) Toner Cartridges)” P.96.

1

Prepare a new [C] toner cartridge.

2

Insert your finger into the recess on
the right side of the printer and pull the
front cover open lever (1) to open the
front cover (2) forward.

The number of pages that can make prints
depends on the usage.

4. Maintenance

When the “%COLOR% Toner Empty” appears
and printing is stopped, replace the toner
cartridge.
Note

1

●● The actual life of the toner cartridge differs depending on
the usage.
2

3

Turn the blue lever (3) of the toner
cartridge.

Note

●● Have a new print cartridge ready, as the print quality
declines after more than one year following breaking the
seal.
●● If you replace the toner cartridge/image drum while it is
being used, the amount of toner used will not be counted
normally.

3

●● By opening and closing the output tray after the message
“Color toner empty.” is displayed, you are able to print
approximately 100 copies of A4 size ISO test patterns
(approximately 20 pages, five times). However further
printing operations will not be possible after that. Please
replace the toner cartridge as failure to do so may
damage the image drum.

- 94 -

Replacing Consumables and Maintenance Units

4

Lift the toner cartridge (4) from the right
side, and remove it from the printer.

WARNING

7

Possible to get
burned.

●● Do not throw a used toner cartridge in the
fire. They may explode, and the toner inside
may fly off and cause getting burned.

Insert a new toner cartridge (6) by
aligning its left side indentation (7) with
the protrusion (8) on the image drum so
the toner cartridge and image drum [C]
color label align. Then fix the right side
firmly into place.
Note

●● Do not insert a toner cartridge without removing the
tape.

Note

●● When toner powder adheres to the paper feeding
area inside the printer, wipe it off with a wet cloth
that has been well wrung.
6
8

4

5

Turn the blue lever (3) of the toner
cartridge backward until its top aligns on
the mark.

Leaving the replacement toner cartridge
in its bag, gently shake it up and down
and side to side, and then unpack it.

3

6

Remove the tape (5) from the toner
cartridge.

9

Close the front cover (2).
Note

●● The front cover cannot be closed if the output tray is
not closed securely.

5

2
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8

4

7

Replacing Consumables and Maintenance Units

10 Please recycle toner cartridges.
Memo

●● If you must dispose of a toner cartridge, put it in a
plastic bag or similar container and dispose of it in
accordance with your municipality’s ordinances or
guidelines.

Procedure for Replacement
(for W (white), M (magenta),
Y (yellow) Toner Cartridges)
Memo

●● When replacing the C toner cartridge, refer to “Procedure
for Replacement (for C (cyan) Toner Cartridge)” P.94.

1

Prepare new toner cartridges.

2

Insert your finger into the recess on
the right side of the printer and pull the
front cover open lever (1) to open the
front cover (2) forward.

4
4. Maintenance

1

2

3

Press the output tray open button (3)
and open the output tray (4).

CAUTION

Possible to get
burned.

●● The fuser unit is extremely hot. Do not touch
it.
3
4
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4

Identify an empty toner cartridge by its
label color (5).

7

Unpack the replacement toner cartridge,
and gently shake it up and down and
side to side.

8

Remove the tape (8) from the toner
cartridge.

5

5

Slide the right blue lever (6) of the toner
cartridge while pressing the top of the
cartridge to unlock.

9

6

6

Lift the toner cartridge (7) from right
side, and remove it from the printer.

WARNING

Possible to get
burned.

Insert a new toner cartridge (9) by
aligning its left side indentation (10)
with the protrusion (11) on the image
drum so the toner cartridge and image
drum color labels align. Then fix the
right side firmly into place.
Note

●● Do not insert a toner cartridge without removing the
tape.

●● Do not throw a used toner cartridge in the
fire. They may explode, and the toner inside
may fly off and cause getting burned.

9
7

11
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8

4

Replacing Consumables and Maintenance Units

10 Turn the blue lever (6) of the toner

Replacing the Image Drum

cartridge backward until its top aligns on
the mark.

Life Span of Image Drum
When the “%COLOR% Image Drum Near
Life” message appears on the display screen,
prepare a replacement image drum.
If you continue printing, the message
“%COLOR% Image Drum Life” will be
displayed and printing will stop.
6

4

11 Close the output tray (4) by pushing the
both sides of the cover firmly.

4. Maintenance

4

A guideline for replacing the image drum is
every 30,000 pages (YMC), every 9,000 pages
(W) or so for A4 sized paper (with single-sided
printing). However, this number of pages is for
common printing conditions (3 pages at a time).
Printing one page at a time reduces the drum
life by about half.
The actual number of printed pages may be
halved again relative to the above guideline,
depending on the printing conditions.
If you continue to print more than the above,
the printer will force the printing to stop.
Note

●● The actual number of pages you can print with the image
drum depends on how you use it. The above guideline
may be reduced by more than half, depending on the
conditions of printing.
●● Though opening and closing the output tray may extend
the life of a image drum for a while, it is recommended to
replace it soon after the “Install New image drum” is
displayed.

12 Close the front cover (2).

●● The print quality may deteriorate after the toner cartridge
has been unpacked for a year. Replace it with a new one.
●● Press the scroll button
or
and select [Admin Setup] >
[Panel Setup] > [Near Life Status], if this is set to
[Disable], then the “%COLOR% Image Drum Near
Life” message does not appear.

Procedure for Replacement
Note

2
Note

●● The front cover cannot be closed if the output tray is
not closed securely.

13 Please recycle toner cartridges.
Memo

●● If you must dispose of a toner cartridge, put it in a
plastic bag or similar container and dispose of it in
accordance with your municipality’s ordinances or
guidelines.

●● If you use a new image drum with the toner cartridges
currently in use, the remaining amount indication of the
toner cartridges will not display correctly.
The messages “%COLOR% Image Drum Near Life” or
“%COLOR% Image Drum Life” may also be displayed
soon after replacement.
●● The image drum (the green tube) is very delicate. Handle
it carefully.
●● Do not expose the image drum to direct sunlight or very
bright interior light (approximately more than 1500 lux).
Even under the normal interior light, do not leave it for
more than 5 minutes.
●● In order for the printer to exhibit its full performance,
please use genuine OKI consumables.
●● Service for problems due to use of consumable items
other than genuine OKI consumables will incur fees
even in the warranty period or the maintenance contract
period. (Use of consumable items other than genuine OKI
consumables does not always cause problems, but please
exhibit caution when using those.)
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●● There is one toner cartridge for each color on the image
drum.

1

Prepare a new image drum.

2

Insert your finger into the recess on
the right side of the printer and pull the
front cover open lever (1) to open the
front cover (2) forward.

5

Remove the image drum (6) from the
printer in the direction of the arrow and
place the image drum on a flat surface.
6

4

1

3

Press the output tray open button (3)
and open the output tray (4).

CAUTION

Turn the right blue lever (7) of the toner
cartridge forward while pressing the top
of the toner cartridge to unlock.

Possible to get
burned.

●● The fuser unit is extremely hot. Do not touch
it.

7

3
4

7

Lift the toner cartridge (8) from the
right side, and remove it from the image
drum.

WARNING
4

Possible to get
burned.

●● Do not throw a used image drum and toner
cartridge in the fire. They may explode, and
the toner inside may fly off and cause getting
burned.

Identify an empty toner cartridge by its
label color (5).
5

8
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6

2

Replacing Consumables and Maintenance Units

8

Remove the protective sheets.
Place a new image drum (9) on a flat
surface.

11 Turn the blue lever (7) of the toner

cartridge backward until its top aligns on
the mark.

9

7

4

9

Remove the toner cover (10).

12 Check a label color of a new image drum
(9) and place the drum into a printer.

10

4. Maintenance

9

10 Insert the toner cartridge (8) taken

out in step 7 to the image drum (9) by
aligning its left side indentation (11)
with the protrusion (12) on the image
drum, and then fix the right side firmly
into place.

13 Close the output tray (4) by pushing the
both sides of the cover firmly.
4

8
12
11
9
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14 Close the front cover (2).

Replacing the Belt Unit

Note

●● The front cover cannot be closed if the output tray is
not closed securely.

Life Span of Belt Unit
When the “Belt Unit Near Life” message
appears on the display screen, prepare a
replacement belt unit. You can keep printing
approximately 1,000 pages until the next
message appears.
When the “Change Belt Unit” message
appears, replace the belt unit.
The life expectancy of the belt unit is
approximately 30,000 pages for A4 simplex
printing (three pages per job).

2

4

Note

●● The actual number of pages you can print with the belt
unit depends on how you use it.

Memo

Note

●● If you must dispose of an image drum, put it in a
plastic bag or similar container and dispose of it in
accordance with your municipality’s ordinances or
guidelines.

●● Though opening and closing the output tray may extend
the life of the belt unit somewhat, you should replace it
soon after the “Change Belt Unit” is displayed to prevent
malfunction.
●● If you replace the belt unit, use it until the end of its
useable life. If you remove the belt unit and install and
use another one before its usable life has expired, the use
life will not be correctly displayed.

If the light-shielding film of the
image drum becomes dirty, wipe
the film by following the procedures
below.

●● Press the scroll button
or
and select [Admin Setup] >
[Panel Setup] > [Near Life Status], if this is set to
[Disable], then the “Belt Unit Near Life” message does
not appear.

(1) Open the front cover.
(2) Open the output tray.

Procedure for Replacement

(3) Remove the image drum.
(4) Wipe the light-shielding film with soft
tissue paper.

Note

●● The image drum (the green tube) is very delicate. Handle
it carefully.
●● Do not expose the image drum to direct sunlight or very
bright interior light (approximately more than 1500 lux).
Even under the normal interior light, do not leave it for
more than 5 minutes.

1

Prepare a replacement belt unit.

2

Turn off your printer by pressing the
power switch.

(5) Put the image drum back to the
printer.

(6) Close the output tray by pushing the
both sides of the cover firmly.

Reference

(7) Close the front cover.

●● “Turning Off the Power” P.22
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15 Please recycle image drums.

Replacing Consumables and Maintenance Units

3

Insert your finger into the recess on
the right side of the printer and pull the
front cover open lever (1) to open the
front cover (2) forward.

6

Cover the image drums you took out
with paper so that the image drums do
not expose to the light.

7

Turn the blue locks (5) on each side of
the belt unit in direction of the arrow to
unlock.

1

4

2

4. Maintenance

4

Press the output tray open button (3)
and open the output tray (4).

CAUTION

5

Possible to get
burned.

●● The fuser unit is extremely hot. Do not touch
it.

5

3
4

8

5

Remove the belt unit by holding the blue
lever (6).

Take all the four image drums out of a
printer, and then place them on a flat
surface.
6
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9

Hold the handle of a new belt unit with
one hand and support lower part with
other hand. Place the belt unit into the
printer.

11 Return all the four image drums to the
printer.

4
both sides of the cover firmly.
4

10 Turn the blue locks (5) on each side of
the belt unit in direction of the arrow.

13 Close the front cover (2).
Note

5

●● The front cover cannot be closed if the output tray is
not closed securely.
5

2

14 Please recycle belt unit.
Memo

●● If you must dispose of a belt unit, put it in a
plastic bag or similar container and dispose of it in
accordance with your municipality’s ordinances or
guidelines.
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12 Close the output tray (4) by pushing the

Replacing Consumables and Maintenance Units

3

Replacing the Fuser Unit
Life Span of Fuser Unit

Insert your finger into the recess on
the right side of the printer and pull the
front cover open lever (1) to open the
front cover (2) forward.

When the “Fuser Unit Near Life” message
appears on the display screen, prepare a
replacement fuser unit. You can keep printing
approximately 1,500 pages until the next
message appears.
When the “Change Fuser Unit” message
appears, replace the fuser unit.

4

1

The life expectancy of the fuser unit is up to
50,000 pages for A4 simplex printing.

2

Note

●● The actual number of pages you can print with the fuser
unit depends on how you use it.

4. Maintenance

4

Note

●● Though opening and closing the output tray may extend
the life of the fuser unit somewhat, you should replace it
soon after “Change Fuser Unit” is displayed to prevent
malfunction.

Press the output tray open button (3)
and open the output tray (4).

CAUTION

●● If you replace the fuser unit, use it until the end of its
useable life. If you remove the fuser unit and install and
use another one before its usable life has expired, the use
life will not be correctly displayed.
●● Press the scroll button
or
and select [Admin Setup] >
[Panel Setup] > [Near Life Status], if this is set to
[Disable], then the “Fuser Unit Near Life” message
does not appear.

Possible to get
burned.

●● Since the fuser unit gets hot, carry out the
operation carefully, and when lifting it up
you must hold it by the handle. Do not try to
hold it whilst it is hot. Wait until it has cooled
down and then carry out the operation.
3
4

Replacement Procedure
Note

●● Do not expose the image drum to direct sunlight or very
bright interior light (approximately more than 1500 lux).
Even under the normal interior light, do not leave it for
more than 5 minutes.

1

Prepare a new fuser unit.

5

Pull forward the left locking lever (5) of
the fuser unit to unlock.

5

2

Turn off your printer by pressing the
power switch.
Reference

●● “Turning Off the Power” P.22
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6

9

Hold the fuser unit handle (6) and lift
the fuser unit out of the printer.

Close the output tray (4) by pushing the
both sides of the cover firmly.
4

6

4

10 Close the front cover (2).
Note

Hold the fuser unit handle (6) and place
the fuser unit into the printer.
6

2

11 Please recycle fuser unit.
Memo

8

●● If you must dispose of a fuser unit, put it in a
plastic bag or similar container and dispose of it in
accordance with your municipality’s ordinances or
guidelines.

Push back the left locking lever (5) of
the fuser unit to lock.

5
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7

●● The front cover cannot be closed if the output tray is
not closed securely.

Cleaning

●●
Cleaning
This section explains how to clean each part of your printer.

Cleaning the Surface of the
Printer

2

Wipe the two paper feed rollers (2)
inside the printer with a wet cloth that
has been wrung out well.

Note

●● Do not use benzine, thinners, or alcohol as a cleaning
agent. They may damage the plastic parts of the printer.
●● Do not lubricate your printer with oil.

4

1

Turn off your printer by pressing the
power switch.
Reference

2

●● “Turning Off the Power” P.22

4. Maintenance

2

3

Wipe the surface of the printer with a
soft cloth lightly moistened with water or
neutral detergent.

3

Remove paper loaded in the tray.

4

Wipe the paper feed roller (3) on the
tray with a wet cloth that has been
wrung out well.

Dry the surface of the printer with a dry
soft cloth.

Cleaning Paper Feed Rollers
Clean the paper feed rollers if paper jams occur
frequently.

3

Note

●● You should replace the paper feed rollers if paper jams
keep occurring even after cleaning the paper feed rollers.

For Tray 1
1

Pull out the tray (1).

5

Load paper in the tray.

6

Push the tray back into the printer.

For MP Tray
1

Open the MP tray (1) forward by
inserting your fingers into the front
recesses (2).
2

1

1
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2

Cleaning

2

Release the tab (3) of the paper feed
roller cover by pressing the right arm (4)
inward while lifting up the MP tray (1)
lightly.

5

Wipe the two paper feed rollers (6) with
a wet cloth that has been wrung out
well.
6

4

1

3

3

6

Open the separation roller cover (7)
forward while pressing the center part of
the MP tray.
Wipe the two separation roller (8) with a
wet cloth that has been wrung out well.

4
8

3
7

1

4

7

Close the separation roller cover (7).

Open the paper set cover (5) until
touching the printer.

5

7

8

Lower the paper set cover (5).
5
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Also press the left arm (4) inward while
lifting up the MP tray (1) lightly to
release the tab (3) of the paper feed
roller cover.

Cleaning

9

Hook one tab (3) of the paper feed roller
cover by pressing the right arm (4)
inward while lifting up the MP tray (1)
lightly.
Note

●● If closing the MP tray without returning the tab to the
correct position, the paper set cover may be broken.
Be sure to return the tab to the original position.

Cleaning LED Heads
Clean the LED heads if vertical lines appear,
images are fading vertically, or the periphery of
letters is smudged in the printouts. Dirt on the
LED heads may also cause paper jams.
Note

●● Do not use methyl alcohol or thinners as a cleaning agent.
They may damage the LED heads.

4

●● Do not expose the image drum to direct sunlight or very
bright interior light (approximately more than 1500 lux).
Even under the normal interior light, do not leave it for
more than 5 minutes.

4

1
1

Turn off your printer by pressing the
power switch.
Reference

3

4. Maintenance

●● “Turning Off the Power” P.22

10 Also hook the other tab (3) of the paper

feed roller cover by pressing the left arm
(4) inward while lifting up the MP tray
(1) lightly.

2

Insert your finger into the recess on
the right side of the printer and pull the
front cover open lever (1) to open the
front cover (2) forward.

Note

●● If closing the MP tray without returning the tab to the
correct position, the paper set cover may be broken.
Be sure to return the tab to the original position.
4

1

3
2

3

Press the output tray open button (3)
and open the output tray (4).

CAUTION

1

Possible to get
burned.

●● The fuser unit is extremely hot. Do not touch
it.

11 Close the MP tray (1).
If the MP tray cannot be closed, return the paper
set cover to the correct position by pressing the
paper loading part on the MP tray downward.

1

- 108 -

3
4

Cleaning

4

Lightly wipe the lenses (5) of the LED
heads with soft tissue paper.

5

4
5

4

6

Close the front cover (2).
Note

●● The front cover cannot be closed if the output tray is
not closed securely.

2
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Close the output tray (4) by pushing the
both sides of the cover firmly.

Moving or Transporting Your Printer

●●
Moving or Transporting Your Printer
This section explains how to move or transport your printer.

Moving Your Printer

2

Unplug all the cables.
●● AC cord and ground wire.

CAUTION

It may cause
injury.

●● Ethernet or USB cable.

●● At least two people are needed to lift the printer
safely because it weighs about 37 Kg.

4

1

3

Remove any paper from the paper trays.

4

Insert your finger into the recess on
the right side of the printer and pull the
front cover open lever (1) to open the
front cover (2) forward.

Turn off your printer by pressing the
power switch.
Reference

●● “Turning Off the Power” P.22

4. Maintenance

2

Unplug all the cables.
●● AC cord and ground wire
●● Ethernet or USB cable

3

Remove any paper from the paper trays.

4

Lift your printer and move it to a new
location.

2

Transporting Your Printer
CAUTION

5

It may cause
injury.

Possible to get
burned.

●● The fuser unit is extremely hot. Do not touch
it.

Possible to get
burned.

3

●● The fuser unit is extremely hot. Do not touch
it.
Note

●● The image drum (the green tube) is very delicate. Handle
it carefully.
●● Do not expose the image drum to direct sunlight or very
bright interior light (approximately more than 1500 lux).
Even under the normal interior light, do not leave it for
more than 5 minutes.

1

Press the output tray open button (3)
and open the output tray (4).

CAUTION

●● At least two people are needed to lift the printer
safely because it weighs about 37 Kg.

CAUTION

1

Turn off your printer by pressing the
power switch.
Reference

●● “Turning Off the Power” P.22
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Moving or Transporting Your Printer

6

Hold the toner cartridges with both
hands and remove them with the image
drums. Remove all the toner cartridges
and image drums, and place them on a
flat surface.

9

Close the output tray (4) by pushing the
both sides of the cover firmly.
4

4

10 Close the front cover (2).
Note

7

Secure each toner cartridge to each
image drum with vinyl tape (5).

5
2

8

Return all the toner cartridges and
image drums to the printer.

11 Protect your printer with packing
materials.

12 Lift your printer and put it in a box.
Note

●● Use the packing materials attached to your printer
when purchased.
●● After transporting or when setting up again, remove
the vinyl tape used to secure the image drum and
toner cartridges.
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●● The front cover cannot be closed if the output tray is
not closed securely.

Before Machine Disposal

●●
Before Machine Disposal
Before this machine is disposed of, it is recommended to erase the registered privacy data and the
stored data.
The data stored in the machine is shown below.
●● Admin password
●● Registered settings in various menus
●● Private printing data
●● Various records
●● Access control, user management data (local user, external user cache [LDAP, Kerberos])

4
4. Maintenance

1

Press the scroll button
operator panel.

2

Press the scroll button to select
[Admin Setup], and press the
<ENTER> button.

3

Input the admin password.

4

Select [Others Setup] > [Erase
Privacy Data].

5

Once [Are You Sure?] is displayed,
select [Yes], and press the <ENTER>
button.

6

Once [Would you like really?] is
displayed, select [Yes], and press the
<ENTER> button.

or

on the

Restart the machine to erase the data.
Note

●● Once the action is executed, the erased data cannot
be restored. To cancel the erasing, select [No] in
Step 5 or Step 6.
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This chapter explains the specifications of your printer.

●●
Menu List of the Operator Panel
Checking the Printer’s Status with the Display Screen
From the <ENTER> button on the operator panel, you can check the status of your printer.

5
You can check the residual life of the consumables, counter information, network settings and system
information on the display screen.

1

Press the button on the operator panel
to open the status menu.

2

Press the scroll button to select the
item you want to check and then press
the <ENTER> button.
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Checking the Device Status

Menu List of the Operator Panel

Menu List of the Operator Panel
The function number is described on the right of each item.
Functions
Print From USB Memory

Print

Configuration

Select Print File
Print Setup

Shared Print
Private Print

F1
F2

: You must input a password.

Tray Count

MPTray
Tray1

A4/Letter Impressions Count

Color

Supplies Life

Cyan Toner (n.nK)
Magenta Toner (n.nK)
Yellow Toner (n.nK)
White Toner (n.nK)
Cyan Drum
Magenta Drum
Yellow Drum
White Drum
Belt
Fuser

Network

Network Information

Printer Name
Short Printer Name
Enabling Default Gateway
(When Wireless LAN is installed)
Wired
IPv4 Address
Subnet Mask
Gateway Address
MAC Address
NIC Program Version
Web Remote Version
IPv6 Address (Local)
IPv6 Address (Stateless Address)
IPv6 Address (Stateful Address)

Wireless(Infrastructure) Information
(When Wireless LAN is installed)

Firmware Version
Wireless(Infrastructure)
SSID
Security
State
Band
Channel
RSSI
IPV4 Address
Subnet Mask
Gateway Address
MAC Address
IPv6 Address (Local)
IPv6 Address (Stateless Address)
IPv6 Address (Stateful Address)

Wireless(AP Mode) Information
(When WirelessL AN is installed)

Wireless(AP Mode)
SSID
Password
Number of connected
IPv4 Address

5
5. Appendix

System

To NEXT PAGE

Paper Feed
Copies
Fit
Color Mode

Serial Number
Asset Number
Lot Number
Firmware Version
CU Version
PU Version
Panel Version
RAM
Flash Memory
SD Card
Date and Time
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Print Information

Configuration
Network
Demo Page
File List
PS Font List
Error Log
Color Profile List
Job Log

Menus

Tray Configuration

F100
F101
DEMO1
...

F103

Memo
(

) indicates the factory default setting.

MPTray Config

Paper Size (A4
)
X Dimension (210millimeter)
Y Dimension (297millimeter)
Media Type (Plain)
Media Weight (Light)
Tray Usage (When Missmatching)

F90
F91
F92
F93
F94
F95

Tray1 Config

Paper Size (Cassete Size)
X Dimension (210millimeter)
Y Dimension (297millimeter)
Media Type (Plain)
Media Weight (Light)
Legal Paper (Legal14)

F10
F11
F12
F13
F14

Othre Size (16K (184x260mm)

System Adjust

F80

Power Save Time (1 minute)
SleepTime (15 minutes)
Auto Power Off Time (4 hours)
Silent Mode (On)
Clearable Warning (ONLINE)
Auto Continue (Off)
Manual Timeout (60 seconds)
Timeout InJob (40 seconds)
Timeout Local (40 seconds)
Timeout Network (90 seconds)
Low Toner (Continue)
Print Mode w/o Color Toner
(Alarm)
Jam Recovery (On)
Error Report (Off)
Hex Dump

F200
F201
F202

F210
F237

Print Position Adjust

Paper Color Setting (0)
Trans. Color Setting (0)
SMR Setting

F231
F233
F234

BG Setting

F235

HU Setting (Off)
VL Cleaning
Drum Cleaning (Off)
High Humid Mode (Off)
Moisture Control (Off)
Narrow Paper Speed (Mode1)
Warmup Control (Off)
Quiet Mode (Off)
To NEXT PAGE
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Print Adjust

Paper Feed (Tray1)
Auto Tray Switch (On)
Tray Sequence (Down)

)

F236

MPTray

F220

X Adjust (0.00millimeter)
Y Adjust (0.00millimeter)

Tray1

F221

X Adjust (0.00millimeter)
Y Adjust (0.00millimeter)

Cyan (0)
Magenta (0)
Yellow (0)
White (0)
Cyan (0)
Magenta (0)
Yellow (0)
White (0)

Menu List of the Operator Panel

Admin Setup

Network Setup

Enabling Default Gateway
(When Wireless LAN is installed)
Wired (Enable)
TCP/IP (Enable)
NetBIOS over TCP (Enable)
IP Address Set (Auto)
IPv4 Address
(When the IP address is set manually)

: You must input
a password.

Subnet Mask
(When the IP address is set manually)
Gateway Address
(When the IP address is set manually)
DHCPv6 (Disable)
Web (Enable)
Telnet (Disable)
FTP (Disable)
IPSec (if enabled) (Disable)
SNMP (Enable)
Network Scale (Normal)
Gigabit Network (Disable)
Hub Link Setting (Auto Negotiate)
Network Factory Defaults
USB Setup

USB (Enable)
Speed (480Mbps)
Soft Reset (Disable)
Serial Number (Enable)
Offline Receive (Disable)
USB Memory Interface (Enable)
Connected Host (Normal)

Print Setup

Personality (Auto)
Copies (1)
Media Check (Enable)
A4/Letter Override (Yes)
Resolution (600dp)
X Dimension (210millimeter)
Y Dimension (297millimeter)

PS Setup

L1 Tray (Type1)
Network Protocol (RAW)
USB Protocol (RAW)

Private Print Setup
(When SD Memory
card is installed)

Verify job option (Disable)
Erase job option (No overwrite)
Keep job for (2 hours)
Job Limitation (Disable)
Verify job password (Off)
Job Auto Search (On)

Color Setup

CMY 100% Density (Disable)

Panel Setup

Near Life Status (Enable)
Near Life LED (Enable)
Idle Display (Toner Gauge)
Panel Contrast (0)

Buzzer Setup

Paper Jam Error Buzzer Volume (Off)

Time Setup

Date Format (dd/mm/yyyy)
Time Zone (+0:00)
Daylight Saving (Off)
Setting method (Manual Setup)
SNTP Server (Primary)
SNTP Server (Secondary)
Time Setting (01/01/2000 00 :00)

Power Setup

Auto Power Off (Auto Config)

Tray Setup

Unit Of Measure (millimeter)
Default Paper Size (A4)

5
5. Appendix
To NEXT PAGE
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Others Setup

RAM Setup

Receive Buffer Size (Auto)
Resource Save (Off)

Flash Memory Setup

Initialize

SD Card Setup
(When SD Memory card is installed)

Initialize
Format Partition (PCL)
Erase SD Card

Storage Common Setup

Check File System
Check All Sectors
Enable Initialization (No)

Job Log Setup

Clear Job Log

Security Setup

Access Control (Disable)
User Counter Report

Language Setup

Select Language (English)
Language Initialize

Job Cancel Setup

Cancel Key Behavior (Short)
Inquiry Display (On)
Focus Position (Yes)
Display Timeout (180)

Near Life Setup

Fuser Near Life Timing (1500)
Belt Near Life Timing (1000)

Business Phone Setup

Calibration

To NEXT PAGE

Settings

Reset Settings
Save Settings
Restore Settings

Change Password

New Password

Auto Density Mode (On)
Adjust Density
Adjust Registration
Color Density

F300
F301

Print Color Tuning Pattern

F302

Cyan Density (0)
Magenta Density (0)
Yellow Density (0)
White Density (0)

Cyan Tuning

Highlight (0)
Mid-Tone (0)
Dark (0)

Magenta Tuning

Highlight (0)
Mid-Tone (0)
Dark (0)

Yellow Tuning

Highlight (0)
Mid-Tone (0)
Dark (0)
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Business Phone Cooperation (Disable)
Connection IP Address (0.0.0.0)
Connection Port No. (59000)

Verify Password

F310
F311
F312
F313

5. Appendix

Erase Privacy Data

5

Menu List of the Operator Panel

Wireless(Infrastructure) Setting
(When Wireless LAN is installed)

Wireless(Infrustructore) (Disable)
Network Setting

IP Address Set (Auto)
IPv4 Address
(When the IP address is set
manually)
Subnet Mask
(When the IP address is set
manually)
Gateway Address
(When the IP address is set
manually)
DHCPv6 (Disable)

Automatic setup (WPS)

WPS-PBC
WPS-PIN

Wireless Network Selection

xxxxxx
......

: You must input a password.

Manual Setup

5
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Wireless reconnection
Wireless(AP Mode) Setting
(When Wireless LAN is installed)

Wireless(AP Mode) (Disable)
Automatic Setup (PushButton)
Manual Setup
Connection Setting

AP Mode User Setting (Don’t disclose use)

Boot Menu
: You must input a password.

To display the [Boot Menu],
turn on the power while pressing
the <ENTER> button.

Network Factory Defaults
Wireless Module (Disable)
SD Card Setup
(When SD Memory card is installed)
Storage Common Setup

Enable SD Card (Yes)
Check File System
Check All Sectors

Menu Lockout (Off)
Panel Lockout (Off)
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SSID
Password
IPv4 Address
Execute

SSID
Security (Disable)
WEP Key
(When the security is set to WEP)
WPA Encryption Type
(When the security is set to
WPA/WPA2-PSK or WPA2-PSK)
WPA Pre-Shared Key
(When the security is set to
WPA/WPA2-PSK or WPA2-PSK)
Execute

Specifications

●●
Specifications
Model
Pro8432WT

Model Number
N35100A, N35100B

 General Specifications
Pro8432WT
CPU
Memory
Resident
(Maximum
Option
768 MB)
Flash ROM
Storage Device

Weight
Dimensions
Power supply

Interface
Display
Supported OS

Typical
operation
Idle
Peak
Deep sleep
mode
Power save
mode
Off mode

System Memory : 128MB
SD memory card kit
●● Optional
16 GB
37 Kg (including consumables)
449(W) x 552(D) x 360(H) mm
N35100A :
110 - 127 VAC (Range 99 - 140 VAC), 50/60 Hz ± 2%
N35100B :
220 - 240 VAC (Range 198 - 264 VAC), 50/60 Hz ± 2%
700 W
100 W
1400 W
Voltage 110 - 127 VAC : Less than 0.7 W
Voltage 220 - 240 VAC : Less than 1.0W
Less than 12 W
Voltage 110 - 127 VAC : Less than 0.1 W
Voltage 220 - 240 VAC : Less than 0.15 W
USB 2.0 (Hi-Speed), Ethernet 10BASE-T/100BASE-TX/1000BASE-TX
Graphics panel 60(W) x 32.6(H) mm, 128 x 64 dots
●● Windows 10, Windows 8.1, Windows 8, Windows 7, Windows Vista, Windows
Server 2016, Windows Server 2012 R2, Windows Server 2012, Windows Server
2008 R2, Windows Server 2008
●● OS X 10.8.5-macOS Sierra
Please refer to product requirements for details.
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Power
consumption

PowerPC464FP, 800 MHz
256 MB
256 MB/512 MB

Specifications

 Printing Specifications
Pro8432WT
Printing method
Emulation language
Resident fonts
Resolution
Color
Print speed (A4)
Paper size
Tray 1

MP Tray

Custom size

5
Media type

5. Appendix

Feeding method
Paper loading capacity

Dry electrophotographic recording method with LED (Light-emitting diode)
PostScript 3
PS: 80 european fonts
600 x 600 dpi, 600 x 1200 dpi, 600 x 600 dpi 2bit
Yellow, Magenta, Cyan, White
Simplex: 35 ppm
Legal 13/13.5/14, letter, executive, tabloid, A3, A4, A5, B5, B4, A6, B6,
Statement, 8.5SQ, Folio, custom size, 8K (260 x 368 mm, 270 x 390 mm, 273 x
394 mm), 16K (197 x 273 mm, 195 x 270 mm, 184 x 260 mm)
Legal 13/13.5/14, letter, executive, tabloid, statement, A3, A4, A5, B4, B5, A6,
B6, B6 Half, 8.5SQ, Folio, 4x6inch, 5x7inch, index card (3 x 5 inch), custom size,
8K (260 x 368 mm, 270 x 390 mm, 273 x 394 mm), 16K (197 x 273 mm, 195 x
270 mm, 184 x 260 mm)
●● Tray 1
105 - 297 mm (W),
148, 182 - 431 mm (L)
(4.1 - 11.7 inches (W),
5.8 - 17.0 inches (L))
●● MP tray
64 - 297 mm (W),
90 mm - 431 mm (L)
(2.5 - 11.7 inches (W), 3.5 inches - 17.0 inches (L))
Plain paper (64 g/m2 - 256 g/m2), letterhead, transparency, bond, recycle, card
stock, rough
Automatic feeding from the tray 1 and MP tray
Manual feeding from MP tray
●● Tray 1
300 sheets of Standard paper /80 g/m2, total thickness 30 mm or lower.
●● MP tray
100 sheets of Standard paper /80 g/m2 and total thickness 10 mm or lower, 10

Output method
Paper output capacity

envelopes/ weight of 85 g/m2.
Face up/Face down
●● Face up
100 sheets (less than 80 g/m2), 10 sheets (ultra-heavy/envelopes)
●● Face down

Print guaranteed area
Print precision
Warm-up time

Operating environment

Conditions for the guarantee
of print quality

Consumables, Maintenance
Unit

200 sheets (less than 80 g/m2)
6.35 mm or more from the paper edge (not applicable to special media such as
envelopes)
Print beginning:± 2 mm, paper skew:± 1 mm/100 mm,
image expansion:± 1 mm/100 mm (80 g/m2)
●● From power on
32 seconds (at room temperature 25°C, rated voltage)
●● From power save mode
27 seconds (at room temperature 25°C, rated voltage)
●● When in operation
10 - 32°C / Relative Humidity of 20 - 80% (maximum wet bulb temperature of
25°C, maximum dry bulb temperature of 2°C)
●● When not in operation
0 - 43°C / Relative Humidity of 10 - 90% (maximum wet bulb temperature of
26.8°C, maximum dry bulb temperature of 2°C)
●● Operating Range
Temperature 10°C, humidity 20 to 80% RH
Temperature 32°C, humidity 20 to 60% RH
Humidity 20% RH, temperature 10 to 32°C
Humidity 80% RH, temperature 10 to 27°C
●● Full-color Print Quality Assured Range
Temperature 17 to 27°C, humidity 50 to 70% RH
Toner cartridges, image drum, belt unit, fuser unit, feed roller set
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Specifications

 Network Specifications
Pro8432WT
Interface
Protocol

Ethernet 10BASE-T/100BASE-TX/1000BASE-TX
TCP/IPv4&v6, NetBIOS over TCP, DHCP, DHCPv6, BOOTP, HTTP, HTTPS, DNS,
DDNS, WINS, UPNP, Bonjour, SMTP, SMTPS, POP3, POP3S, SNMPv1&v3, SNTP,
IPP, IPPS, WSD Print, LLTD, IEEE802.1X, LPR, Port9100, Telnet, FTP, FTPS, IPSec,
Secure Protocol Server, LDAP, LDAPS

5
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Specifications

Wireless LAN Specifications (Option)
Item
Wireless LAN standard
Security

IEEE802.11a/b/g/n conformity (2.4 GHz / 5 GHz)
Disable, WEP, WPA-PSK, WPA2-PSK, WPA-EAP, WPA2-EAP

Regulatory wireless LAN statements
- FCC Statement
- IC Statement
- Europe-CE Declaration of conformity.
FCC statement
FCC WARNING
Changes or modifications not expressly approved by the party responsible for compliance could void
the user’s authority to operate the equipment.

5
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Note: This equipment has been tested and found to comply with the limits for a Class B digital device,
pursuant to part 15 of the FCC Rules. These limits are designed to provide reasonable protection
against harmful interference in a residential installation. This equipment generates, uses and can
radiate radio frequency energy and, if not installed and used in accordance with the instructions, may
cause harmful interference to radio communications. However, there is no guarantee that interference
will not occur in a particular installation. If this equipment does cause harmful interference to radio
or television reception, which can be determined by turning the equipment off and on, the user is
encouraged to try to correct the interference by one or more of the following measures:
- Reorient or relocate the receiving antenna.
- Increase the separation between the equipment and receiver.
- Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
- Consult the dealer or an experienced radio/TV technician for help.
This transmitter must not be co-located or operating in conjunction with any other antenna or transmitter.
IC statement
This device complies with Part 15 of FCC Rules and Industry Canada licence-exempt RSS standard(s).
Operation is subject to the following two conditions: (1) this device may not cause interference, and
(2) this device must accept any interference, including interference that may cause undesired operation
of this device.
Le présent appareil est conforme aux la partie 15 des règles de la FCC et CNR d’Ubdustrie Canada
applicables aux appareils radio exempts de licence. L’exploitation est autorisée aux deux conditions
suivantes : (1) I’appareil ne doit pas produire de brouillage, et (2) I’utilisateur de I’appareil doit
accepter tout brouillage radioélectrique subi, même si le brouillage est susceptible d’en compromettre
le fonctionnement.
This Class [B] digital apparatus complies with Canadian ICES-003.
Cet appareil numérique de la classe [B] est conforme à la norme NMB-003 du Canada.
Caution (FCC/IC):
5.15-5.25 GHz band is restricted to indoor operations only.
La bande 5150-5250 MHz est restreints à une utilisation à l’intérieur.
This equipment complies with FCC/IC radiation exposure limits set forth for an uncontrolled
environment and meets the FCC radio frequency (RF) Exposure Guidelines and RSS-102 of the IC radio
frequency (RF) Exposure rules. This equipment should be installed and operated keeping the radiator at
least 20 cm or more away from person’s body.
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Specifications

Cet équipement est conforme aux limites d’exposition aux rayonnements énoncées pour un
environnement non contrôlé et respecte les règles les radioélectriques (RF) de la FCC lignes directrices
d’exposition et d’exposition aux fréquences radioélectriques (RF) CNR-102 de l’IC. Cet équipement
doit être installé et utilisé en gardant une distance de 20 cm ou plus entre le dispositif rayonnant et le
corps.
Europe - CE Declaration of Conformity

This equipment complies with the essential requirements of the European Union directive 2014/53/EU.
The telecommunications functionality of this product may be used in the following EU and EFTA
countries: Austria, Belgium, Bulgaria, Cyprus, Czech Republic, Denmark, Estonia, Finland, France,
Germany, Greece, Hungary, Iceland, Ireland, Italy, Latvia, Liechtenstein, Lithuania, Luxembourg,
Malta, Netherlands, Norway, Poland, Portugal, Romania, Slovak Republic, Slovenia, Spain, Sweden,
Switzerland, Turkey and United Kingdom.
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Specifications

 Printer Dimensions
TOP VIEW

449 mm

SIDE VIEW
1107 mm
255 mm

552 mm

300 mm

400 mm

5
420 mm

5. Appendix

360 mm
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760 mm

Index
A

P

ATTENTION indicator............. 78

Paper Jams.......................... 66

B

Paper Size................ 45, 47, 52
Paper Tray......................47, 52

Belt Unit............................ 101

Paper Weight..................45, 47

C

Placement Environment......... 16
Placement Space.................. 16

Custom Sizes....................... 52

POWER SAVE button............. 22

D

Power Supply Conditions....... 21
Printer Driver....... 34, 38, 41, 42

Deep Sleep Mode.................. 60

Product Requirements........... 30

F

R

Feed Rollers....................... 106

Rear Output Tray.................. 55

Fuser Unit......................... 104

T

I
Toner Cartridges................... 94
Image Drum........................ 98

W

Install
Printer Driver

Windows............................. 30

(OS X)...............38, 42
Printer Driver
(Windows)..........34, 41
IP Address........................... 34

M
MP Tray............................... 49

O
OS X................................... 30
Other Error Messages............ 78
Output Tray......................... 55
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Contact Us
Italia

www.oki.com/it

Français

www.oki.com/fr

Deutschland

www.oki.com/de

United Kingdom

www.oki.com/uk

Ireland

www.oki.com/ie

España

www.oki.com/es

Portuguesa

www.oki.com/pt

Sverige

www.oki.com/se

Danmark

www.oki.com/dk

Norge

www.oki.com/no

Suomi

www.oki.com/fi

Nederland

www.oki.com/nl

België/Belgique

www.oki.com/be

Österreich

www.oki.com/at

Schweiz/Suisse/Svizzera

www.oki.com/ch

Polska

www.oki.com/pl

Česká

www.oki.com/cz

Slovenská

www.oki.com/sk

Magyarország

www.oki.com/hu

Россия

www.oki.com/ru

Україна

www.oki.com/ua

Türkiye'ye

www.oki.com/tr

Serbia

www.oki.com/rs

Croatia

www.oki.com/hr

Greece

www.oki.com/gr

Romania

www.oki.com/ro

OKI Europe

www.oki.com/eu

Singapore

www.oki.com/sg/

Malaysia

www.oki.com/my/

ࡒ࡚ࡧࡳࡎࡷࡎ࡙

www.oki.com/th/printing/

Australia

www.oki.com/au/

New Zealand

www.oki.com/nz/

United States

www.oki.com/us/

Canada

www.oki.com/ca/

Brasil

www.oki.com/br/printing

México

www.oki.com/mx/

Argentina

www.oki.com/la/

Colombia

www.oki.com/la/

Other countries

www.oki.com/printing/
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1-7-12 Toranomon, Minato-ku, Tokyo
105-8460, Japan
www.oki.com/printing/

46603902EE Rev3

